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Introduction

This tutorial teaches you how to create a simple e-business customer inquiry
application that uses a Web-based front end to communicate with the business
logic written in ILE RPG residing on an iSeries™ server. While creating a browser
user interface, you will learn how to use the iSeries Web Interaction wizard to
generate input and output JSP files as well as Page Designer to enhance the input
and output Web pages. You will also add iSeries Web components to your pages,
for example, Web equivalents of iSeries command keys, input fields that accept
only particular types of data, or output fields such as subfile names. You will then
learn how to run the application in the WebSphere® Test Environment that is part
of the product.

Prerequisites

In order to complete this tutorial end to end, you should already have working
knowledge of the following:

+ Basic Microsoft® Windows® operations such as working with the desktop and
basic mouse operations such as opening folders and performing drag-and-drop
operations.

* How Web applications work.
* How to use a browser to navigate the Internet.

It is also useful, but not necessary, for you to have basic knowledge of the
following:

* DDS

+ Servlets and Java™ Server Pages (to understand the generated output of the Web
Interaction wizard)

The file(s) required for this tutorial are available for download at
http://ibm.com/software/awdtools/wdt400/library.

Time required

To complete the modules of this tutorial, you will need approximately 3 hours and
5 minutes.

Learning objectives
The tutorial is broken into 9 modules, each with its own learning objectives. You

can choose to complete one or all of the modules. Each module contains several
exercises that must be completed in order for the tutorial to work properly.

Chapter 1, “Module 1. Introducing the Web customer inquiry application,” on page|
gteaches you about the completed e-business customer inquiry application that
you will build in this tutorial. In this module, you will:

* View a concept diagram of the Web development tools process
* Recognize the capabilities of the iSeries Web tools
* View the finished Web customer inquiry application

© Copyright IBM Corp. 2001, 2006 \'%
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[Chapter 2, “Module 2. Creating an RPG program,” on page 7| teaches you how to
use the Remote System Explorer perspective to edit and compile an iSeries
program that will be invoked by the Web application to get data from the iSeries.
In this module, you will:

» Start the product

» Set the default workspace

* Check the Remote System Explorer perspective is open
» Set up a new connection to an iSeries server

* Locate an RPG source file you want to edit

« Edit an RPG source member with the Remote Systems LPEX Editor
* Highlight the tokens of your RPG source

* Show only comment lines in the RPG source

* Show all lines in the RPG source

* Display a format line

» Compile a program object

Chapter 3, “Module 3. Creating the RPG service program for your Web application|
(optional),” on page 23| teaches you how to use the Remote System Explorer
perspective to edit and compile an iSeries service program that will be invoked by
the Web application to get data from the iSeries. In this module, you will:

» Start the product

» Set the default workspace

* Check the Remote System Explorer perspective is open
« Set up a new connection to an iSeries server

» Locate an RPG source file you want to edit

* Edit an RPG source member with the Remote Systems LPEX Editor
» Highlight the tokens of your RPG source

* Show only comment lines in the RPG source

» Show all lines in the RPG source

» Display a format line

» Compile a service program object

[Chapter 4, “Module 4. Creating a Web project,” on page 41| teaches you about the
Web perspective and the tools in this perspective to help you create a Web project
to contain your Web application files and to supply the information which the
iSeries server will use for serving business information for this Web application. In
this module, you will:

» Access tools and views for iSeries Web application development

* Know the difference between a static Web project and a dynamic Web project

» Set up a dynamic Web project

» Define where the RPG program or service program resides on an iSeries server

[Chapter 5, “Module 5. Creating a Web application,” on page 55| teaches you how to
create a Web interaction to use an input and output page, and to create the servlet
to invoke an RPG program to get data from the iSeries database. You will also
learn how to visualize the flow structure of your Web application using the Web
Diagram editor. In this module, you will:

o Start the Web Interaction wizard
» Create an input page that invokes the interaction

Development Studio Client: iSeries Web tools



Create an output page that displays the results of the interaction

Get the program interface definitions

Specify the input and output parameters

Specify the input parameters to show on the input page

Specify what data to show on the output page

Specify what will happen when an incorrect customer number is entered
Change the background color of the output page

Make sure the customer number field is read only

Know what Struts is all about

View the flow structure of a Struts-based Web application

[Chapter 6, “Module 6. Running the Web application,” on page 89| teaches you how

to run the Web application in the WebSphere Test Environment. You also learn
about the WebSphere Test Environment. In this module, you will:

Check the Web perspective is open

Locate input page of the Web application

Invoke the Web application to run in the WebSphere Test Environment
Test the Web application

[Chapter 7, “Module 7. Debugging a Web application,” on page 95| teaches you how

to set up the debug environment, use a service entry point, add and remove
breakpoints, display a variable, and view the call stack. In this module, you will:

Recognize the features of the iSeries Integrated Debugger
Set breakpoints
Monitor an expression

Expand a thread to show every program, module, procedure and method on the
call stack at the current execution point

Run the program to termination

[Chapter 8, “Module 8. Adding an error page,” on page 103| teaches you how to

create an informative error page for customers when an incorrect customer number
is entered.

Create an error page using Page Designer
Change the Web interaction to use the new error page
View the result of adding flow control to the Web application

[Chapter 9, “Module 9. Enhancing the input page using Web tools,” on page 115|

explains how to add color and some pictures to make the input page of the Web
application more attractive. You will learn how to use the Page Designer tool and
some other related Web tools. In this module, you will:

Locate the Web application input page and start Page Designer
View the title of the input page

Add a style to the input page

Preview the new style for the input page

Start WebArt Designer

Create a logo

Resize the logo

Save the object as a WebArt object

Introduction Vil



» Save the object for a Web page

* Place the object on the Design page

* Add a company name to the input page
* Add an image to the input page

* Add a marquee to the input page

* Apply color to certain areas of text

When you are ready, begin [Chapter 1, “Module 1. Introducing the Web customer]
[inquiry application,” on page 1.
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Chapter 1. Module 1. Introducing the Web customer inquiry
application

This module teaches you about the Web customer inquiry application that you will
build in this tutorial. You will also learn about the iSeries Web tools included with
the product.

In this module, you will:

* View a concept diagram of the Web development tools process
* Recognize the capabilities of the iSeries Web tools

* View the finished Web customer inquiry application

Requirement: Before beginning this module, you should have the prerequisite
knowledge outlined in [“Introduction” on page V.

Exercises

The exercises within this module must be completed in order:
+ [“Introducing iSeries Web Application Development”]|
« [“Introducing the Web customer inquiry application” on page 2|

Time required

This module will take approximately 5 minutes to complete.

Introducing iSeries Web Application Development

With the product you can make your iSeries applications and data accessible
beyond the green-screen interface. You can create a new Web interface that
connects directly to your program’s input and output parameters.

You can create interactive Web pages using Web development tools. You use the
Web Interaction wizard to define how your pages interact with one or more ILE or
non-ILE applications. This wizard generates Java Action classes and JSP files for
use with data from HTML forms. When the end user enters data in a form, the
input becomes data to your ILE and non-ILE programs, and the output from the
programs is formatted for the Web. Your ILE and non-ILE logic can be separated
into different programs for each stage of input and output (known as a Web
interaction), or can be a single service program with entry points to handle each
Web interaction. The following diagram illustrates the Web development tools
process:

© Copyright IBM Corp. 2001, 2006 1



' Web Page | Web Page
J J * input value * outpul value

@ Java Server Pages
Action classes
Action classes |
Output

. APG program J

(input value --> input parameter)

You can easily customize your HTML and JSP files using the editing tools in Web
development tools. You can use these tools to create and update input forms,
change the appearance or placement of blocks of text, and add backgrounds and
images to your pages. The iSeries-specific Web components help you create Web
versions of your input and output pages with the same kinds of input validation,
output formatting, and subfile controls that native DDS screens provide. You do
not need a detailed knowledge of HTML or Java to accomplish these tasks.

You have an easy test mechanism for your Web-enabled applications. You can
easily run your program in the WebSphere test environment of the workbench,
quickly make changes, and retest, rather than redeploy your application every time
you want to verify functions. When you are finished, you can package and deploy
your Web applications as J2EE-based Web archive (WAR) and Enterprise Archive
(EAR) files, and then install them in a WebSphere Application Server.

You have looked at the concept diagram of the Web development tools process and
can recognize the capabilities of the iSeries Web tools and now you are ready to
begin [“Introducing the Web customer inquiry application.”|

Introducing the Web customer inquiry application

2

Before you begin, you must complete [“Introducing iSeries Web Application|
[Development” on page 1)

By the end of this tutorial you will have created a simple e-business customer
inquiry application that uses a Web-based front-end to communicate with RPG
business logic residing on an iSeries server. You will first create the RPG program
or service program for your Web application. You will then create a Web project
and invoke the Web Interaction wizard to create the input and output pages and to
create the servlet to invoke the RPG program or service program to get data from
the iSeries database. Next, you will run the application in the local test
environment on your workstation. You will also create an informative error page
for when a customer enters an incorrect customer number.

Here is what the finished e-business customer inquiry application looks like.

After the WebSphere server has started, your Web application Customer Inquiry
input page (inquiry.jsp) will display in the workbench browser:
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Customer Inquiry

Enter customer number; 0010100
Reset

H

Daone

When you enter a customer number and click the Submit push button, the

Customer Details output page (result.jsp) appears.

=
Customer Details
Customer Number: 0010100
Customer Name: Meridien Electronics Limited
Representative Number: 43443
Contact: Alfredo Bayonne
Phone Number: 206-865-4027
Fax Number; 206-865-4037
Address; 10423 S E. 30th Place
City: Bellevue, VWA
Country: USA
Zip: 93007
| Submit | Reset
=
Dane [——

Next, you click the ﬂ Back button in the browser to return to the Customer
Inquiry input page. Here you enter an incorrect customer number and click

Submit.
] =
Customer Inquiry
Enter customer number | 9999
X

Chapter 1. Module 1. Introducing the Web customer inquiry application
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An error message appears.

=
Customer Inquiry
Enter customer number W
submit | Reset
Customer number 9999 not valid
& ——

You then add a new output error page to improve the message information so that
if a wrong customer number is entered,

=
Customer Inquiry

Enter customer number | 9999
Reset

Daong

an error page opens instead of a message.

Sorry, there 1s no record for that customer number.
Please check the number and try agamn.

Module recap

You have completed [Chapter 1, “Module 1. Introducing the Web customer inquiry|
[application,” on page 1]You have learned how to:

* View a concept diagram of the Web development tools process

* Recognize the capabilities of the iSeries Web tools

* View the finished Web customer inquiry application

Now that you have this introductory knowledge of the product iSeries Web application
development, you can continue with [Chapter 2, “Module 2. Creating an RPG program,’]|

|on page 7| if you want to work with an RPG program or|Chapter 3, “Module 3. Creating|
llthe RPG service program for your Web application (optional),” on page 23] if you want

|to work with an RPG service program.
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Chapter 2. Module 2. Creating an RPG program

This module teaches you how to create the iSeries program that you will be using
for your Web application using the Remote System Explorer perspective. Remote
System Explorer provides a PDM like environment but with a GUI interface, and
full integration with all iSeries programmer tools in the workbench.

In this module, you will:

» Start the product

» Set the default workspace

* Check the Remote System Explorer perspective is open

» Set up a new connection to an iSeries server

* Locate an RPG source file you want to edit

* Open an RPG source member with the Remote Systems LPEX Editor
» Highlight the tokens of your RPG source

* Show only comment lines in the RPG source

» Show all lines in the RPG source

» Display a format line

* Edit an RPG source member with the Remote Systems LPEX Editor
* Compile a program object

If you want to work with a procedure in a service program instead, go to [Chapter 3
[“Module 3. Creating the RPG service program for your Web application (optional),” on|

|Eage 23|

If you haven’t used the LPEX editor before, you may want to spend some time
trying some LPEX editor features.

Exercises

The exercises in this module must be completed in order:

+ [“Exercise 2.1: Starting the product” on page 8|

[“Exercise 2.2: Opening the Remote System Explorer perspective” on page 9
[Exercise 2.3: Creating a connection to the iSeries server” on page 11
[“Exercise 2.4: Finding an iSeries source member” on page 13|

« [“Exercise 2.5: Opening a source member for edit” on page 14|

[Exercise 2.6: Reviewing Remote System LPEX Editor features” on page 15|

+ |“Exercise 2.7: Editing an RPG source member and creating a *PGM object” on|

[page 18|

Time required

This module will take approximately 30 minutes to complete.
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Exercise 2.1: Starting the product

Now go ahead and start the product.

On your desktop taskbar:

Sphere Development Studio Client For iSeries 6.0 #|ék  WebSphere Development Studia Client For iSeries

1. Click Start > Programs > IBM® Rational® > IBM WebSphere Development
Studio Client for iSeries V6.0 > WebSphere Development Studio Client for
iSeries
A dialog for workspace selection will appear asking you for the workspace
location, unless you used the product before and selected not to show this
dialog again.

[workspace Launcher x

Select a workspace

16M Rational Software Development Platform stores your projects in a directory called a workspace.
Select the workspace directory to use for this session.

Workspace: | Ci\Documents and Settings\Administrator|IBMrationalsdps, 0lwsslabixx ﬂ Browse. .. |

™ Use this as the default and do not ask again

[ ox | concel [

The workspace contains all the information about your Development Studio
projects. You can accept the default or store the work related to this tutorial, in
a separate workspace.

2. To name the directory of the workspace as shown above, use the directory
name WSSLABxx.

3. Click OK.

After a few moments of loading, the workbench opens, and the initial window
of the product appears on your desktop.
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@ Remote System Explorer - IBM Rational Software Development Platform

h:.

You have just started the product, set the default workspace and now you are
ready to begin [“Exercise 2.2: Opening the Remote System Explorer perspective.”|

Exercise 2.2: Opening the Remote System Explorer perspective

Before you begin, you must complete [“Exercise 2.1: Starting the product” on page|

Check if the windowv title bar says: Remote System Explorer. If it does all you need
to do is close the Welcome view.

& Remote System Explorer - IBM Rational Software Development Platiorm

- r—_—

| Rational Software Development Platform

Skip the next steps and go directly to [“Exercise 2.3: Creating a connection to thel
iSeries server” on page 11}

To open the Remote System Explorer perspective:

Chapter 2. Module 2. Creating an RPG program 9



1. In the workbench, check whether you have the Remote System Explorer
perspective already open. Look for the icon in the taskbar of the workbench.

2. If you cannot see the icon because the Welcome view is open, click X to close
the Welcome view.

3. If you see it click the RSE icon.

@& Remote System Explorer - IBM Rational Software Development P 3 =10 x|
File Edit Mavigate Search Project Run  Window Help

J - -

( | EE Outline 33\\__ = m
‘ ptgutnne s not, available.

4. Otherwise, click Window > Open Perspective > Remote System Explorer on
the workbench menu.

The Remote System Explorer perspective opens.
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_(of x|
File Edit Mavigate Search Project Run  Window Help
!‘_gj' ]‘ﬁ?'O'Q' J-;;'l E'IW
N7 =
[n : o =
o=0utline &2 8
n{‘\?uﬂlna Is not available.
-4 Windows. ..
€3] _& Linu,..
-\ Power Linux...
i N,
-y ALK,
& B Local...
= Ef Local
| BRemote ... 53\ Tasks |iseries... | ™1 =)
Root Connections | 1z 5 | 2|l -
Mame ] Parent profile | Remote
EfLocal Private Lacal
ElProperties 23 B » =0
Property ] Value |
Narne Mew Connection
Mumber of chi... 7
Tyvpe An expandable prompt fo...
4] | i3
|| #nexpandable prompt .. ection: New Connection |

You have checked that the Remote System Explorer perspective is open and now
you are ready to begin [“Exercise 2.3: Creating a connection to the iSeries server.”|

Exercise 2.3: Creating a connection to the iSeries server

Before you begin, you must complete [“Exercise 2.2: Opening the Remote System|

[Explorer perspective” on page 9.

1. Click the plus sign + beside iSeries under New Connection in the Remote
Systems view.

2. Accept the default profile name.

Chapter 2. Module 2. Creating an RPG program
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@rew x|

Name personal profile
Uniquely name user profile | I

Welcome to Remate Systems, Connections can be sharable by the team or private to
you. Enter a profile name to uniquely identify you from your team members. You wil
decide for each new connection whether it is owned by the team profile or your
prafile,

Profile; | msteckh7tp

Finish Cancel

3. Click Next.
x|
Remole iSeries System Connection
Define connection information | I
Parent profile: |mstedd1?tp _'_I
Connection n. 5400a \
Host name: s400a] ﬂ

Description: |

¥ Werify host name

< Back I Next > [@] Cancel |

In this exercise s400a is used as the name for the iSeries server. You will need
to use the name or IP address of your particular iSeries server.

4. Type a host name, for example, s400a in the Host name field.
The Connection name field will be filled automatically with the same entry.
6. Click Finish.

Your new connection appears in the Remote Systems view and you are ready
to work with objects on this iSeries system.

o

You have set up a new connection to an iSeries server and now you are ready to
begin [“Exercise 2.4: Finding an iSeries source member” on page 13/
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Exercise 2.4: Finding an iSeries source member

Before you begin, you must complete [“Exercise 2.3: Creating a connection to the
[iSeries server” on page 11]

You will see a list of libraries under Library list in the Remote Systems view. No
you locate the source you want to edit.

To find an iSeries source member:

-4 New Connection
- = iseries. ..
| L. Connection created successfull
- E 8y Windows...
e A Linus,
& ) Power Linux...
©Eeus Unix, .
| BBy A%
= £l Local... —

:*Ef Local
g o
&l

Ln Work with libraries. ..
-

7 work with objects. ..

(5. A5 work with members. .,
- Library list

; B Q5Y52924.%lib.prod-sys
B, QSYS.Hib.prod-sys
. H-E Q5YS2 Mib.prod-sys

: ¥ [5 GETDASOL.*pgm.rpgle 4
4 _| ' _rl—J

Note: If you don’t see WSSLABxx in your library list, then you need to add the

W

library. You can right-click the Library list and click Add Library List Entry

from the pop-up menu to add WSSLABXxx to your library list.
Expand your iSeries connections.
Expand iSeries Objects by clicking the plus sign + beside it.
Expand Library List.
Expand the library WSSLABXX.
You will see all objects in this library.
5. Expand the source file QRPGLESRC.

P wbd PR

Chapter 2. Module 2. Creating an RPG program
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& | =l }L_‘,? -

[ -OF] CUSTING *file.dspf |
#-[5 CUSTOMER.*file.pf-dt:
-] CUSTOMLY Hfile.If

| CUSTOMLE, *file.If

| CUSTOMS1, *file.IF

| cusTOMSZ *file.If

| CUSTOMS3 . *file.If
] CUSTOMSH. *fileIF
1[5 EVFEVENT *file pf-dta
(= INVPRINT, *file. pref
PRODDTL, *file. pf-dta
PRODINY. *file. pF-dta
w-[5 PRODLIST.*file.pf-dta
® 5 PRODSHOW.*file.pf-dt
-5 PRODUCT *file.pf-dta
-] PRODUCTIF *file.If

£ -5 QCBLLESRC.*file.pf-sn
[+ -5y QDDSSRC. *file.pf-src
15y QRPGLESRC. *file pf-sr
i 0 GETDASOL.tpgle

=
£
=

Bl
E].
El

€. GETDASOLZ.rpgle
0= GETDATA.rpgle

0 GETDATAS.rpole
0 GETDSSOL.rpgle

: @ [ QSYSPRT.*fle.pf-dta
« = .*.I—J

6. Scroll down to the source members in the expanded list.

|

You have located an RPG source member you want to edit and now you are ready
to begin [“Exercise 2.5: Opening a source member for edit.”|

Exercise 2.5: Opening a source member for edit

Before you begin, you must complete [‘Exercise 2.4: Finding an iSeries source]
[member” on page 13/

A shell source member is provided for you to use.

To edit a source member:
1. Right-click member GETDATA.
2. Click Open with > Remote Systems LPEX Editor on the pop-up menu.
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2 Renote svaens x QRS )

18

=
HS =

|| CUSTOMER. *file. pF-dt:
) | CUSTOMLL  *file.If
L] CUSTOMLS, *file.If
L] CUSTOMSL *file.IF
L] CUSTOMSZ, *file.IF
-, | CUSTOMSS. *file.IF
L) ] CUSTOMS4, *file.IF
-5 EVFEVENT.*file.pf-dta
(=) INVPRINT. *File.pref
5 PRODDTL *file.pf-dta
= PRODINV.*file.pf-dta
=/ PRODLIST.*fille.pf-dta
-5 PRODSHOW. *file. pf-dt
#-[F PRODUCT *file.pf-dta
| PRODUCTIF *file.If
) QCBLLESRC, *file.pF-sn
H QDDSSRC. *file.pf-src
|- 5y QRPGLESRC. *file. pf-sr
G GETDASOL.rpgle
-0 GETDASOLZ.1pgle

-

G- GETDATAS.rpg

I rerrceo .

6] CUSTING. *file.dspf & |
=

.jgnemte System Detz

Go To L4

4 {43 CODE Editor k ‘ Browse With 3

The Editor window opens and you are ready to write your program.

Note: You can also double-click on a member to open the Remote Systems

LPEX editor.

You have opened an RPG source member for edit and now you are ready to begin

[“Exercise 2.6: Reviewing Remote System LPEX Editor features.”|

Before you work with the RPG program source, if you have not worked with the

Remote Systems LPEX editor; go to[‘Exercise 2.6: Reviewing Remote System LPEX]|

If you already know the LPEX editor, then you are ready to write the RPG program; go

to |“Exercise 2.7: Editing an RPG source member and creating a *PGM object” on page]

Exercise 2.6: Reviewing Remote System LPEX Editor features

Before you begin, you must complete [“Exercise 2.5: Opening a source member for]

ledit” on page 14

Before you start, here are some useful tips on using the LPEX editor. Let’s look at
some of the features of the LPEX editor, so you can later easily find your way
around and use them:

ALT+L marks a line

ALT+U unmarks selection
ALT+D deletes a selected text
ALT+C copies selected text
ALT+M moves selected text
Enter inserts a new line
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Highlighting specification fields

The LPEX editor highlights the Tokens (specification fields) of your RPG program
source, providing a separate color for each, improving readability. When you make
changes to a line, the token colors get updated only after you move your cursor off
the line.

To see how token highlighting works:

1.

2.
3.
4

Move the cursor to a Calculation statement.

Position the cursor to column 7 (right next to the C).
Type an asterisk (*).

Move the cursor off the line and watch what happens.

The line where you typed the asterisk (*) becomes a comment line and its color
changes accordingly.

[ ocepararaie x N g

Line 26 Column 27 Replace 1 change
..... CLOND 1Factor1+—+—++++—l—@coda {E) +Extended-factori +++++++

000100 *
000200 *
ooo300 * Seample RPGIV program to access file CUSTOML3
0oo400 * Used in WDT hands on LAB
0o0os00 * Created by Claus Weiss
000600 *
ooo7o0 * F spec for file CUSTOMLI keved by customer number
ooosoo FCUSTOML3 IF E K DISK
0oos00 Fr
001000 DrInput parameter from Web page
001100 DCustnoi 8 like (CUSTNO)
oo1z00 D¥ Data structure to specify output sStructure to retu
001300 I C3STRUC E DS exthame (customl
001400 D feedback s z0
001500 C TENTLY plist
001600 C parm custnoi
001700 Cr paCm cstruc |
001800 [ pacm feedback
002100 C eval feedback="blank

Move the cursor back to column 7 and remove the asterisk (*).
Move the cursor off that line of code and the statement is tokenized.

The token highlighting changes to reflect that this is a non-commented C
specification.

Displaying types of lines

Using the LPEX editor, it is possible to have only particular types of source lines
displayed at a time.

To display types of lines:

1.
2.

Right-click anywhere in the Editor window.

Click Filter view on the pop-up menu.

The menu items list the types of line selections that can be made.
Click Comments.

The Editor window now contains only those RPG statements that are
comments.
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| ceroaiarpaie x N 2
Line 5 Colunn & Insert 3 changes
....... N T T e e
ooo100 ®
ooDzo0 *
000300 * Sample RP program to access file CUSTOML3
000400 ® Used in W hands on LAB
ooosoo ¥ Created by Claus Weiss
000600 *
B ooo7voo0 * F spec for file CUSTONL3 keved by customer numbe
a0osoo F*
001000 D¥Input parameter from Web page
oo1zoo0 DT Data structure to Specify output Structure to re
002400 c* Insert code here ——————-—— >
004600 c* Done with inserting code --——————=-- >
i ooa7oo c®
004900 c*

T

4. Right-click anywhere in the Editor window.
5. Click Show all on the pop-up menu.

Mew

Prompt
Syntax Check Line

ot
copy

Paste

Select
Selected

Meselect

Filter view

Source
Wiew

=1 Add ko Snippets...

Save

All statements types are displayed. In addition,
procedures and others. The Filter Selection opti
selected character string.

Checking the syntax of a file

Syntax checking is available for RPG code, and by

the cursor is moved off the line.

When errors are found, they are displayed following the statement with the error.

Keeping track of columns in a specification line

The format line is at the top of the Editor window,

specification being keyed such as F specs, C specs,

Chapter 2. M

the choices in the pop-up menu
can be used to include only control specifications, user subroutines, and

on under the Selected option in
the Edit menu allows the selection of only those lines containing a particular

default will be active. The
syntax of RPG code is checked automatically when a change is made to a line, and

just above the first statement. A
format line is used to help keep track of the columns in a particular specification
line. The content of the format line can vary to reflect the particular type of

D specs and so on.
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To display a format line:

1. Click a line or use the arrow keys and click the left mouse button to make a
line active.

The format line gets updated as a line gets focus.

You can move the cursor right or left with the arrow keys to go from character
to character, or with the Tab key to go from field to field. An indicator on the
format line moves with the cursor to show in which column the cursor is
positioned.

[ cemataseaie x N =)

Line 11 Column 44 Insert 3 changes
..... DName +++++++++++ETDsFrom+++To/ L+++Iuord3++++1—H

ooo100 *
aoozoo0 *
aoo3oo0 * SJample RPGIV program to access f£)lle CUITOML3
000400 " Used in WDT hands on LAEB
ooosoo n Created by Claus Weias
o0oe00 *
ooo7oo0 * F spec for file CUSTOML3 kevyed by fustomer number
0oos00 FCUSTOMLI IF E E DISE
ooosoo F* ‘
oo1000 D*Inpuc paramecer from Web page
oo1100 DCustnol 8 @E (COSTHNG)
oo1zo00 D* Data structure to specify output Stfucture to retuy
001300 I CSTRUC E DS extname (customl
001400 D feedback s 20
oo1s500 c *ENCLY plisc
001600 C parm custhoil

You can select a format line for any specification you want.
2. Click Source from the Editor menu.
3. Click Select Format Line on the pop-up menu.

The Format Line Selection window opens.

@i Format Line x|

Select format line: | gHe

| oK I Cancel I

Now you can start and create the RPG program.
4. Click OK.

You have highlighted tokens of your RPG source, shown only comment lines,
shown all lines, displayed a format line and now you are ready to begin
[2.7: Editing an RPG source member and creating a *PGM object.”|

Exercise 2.7: Editing an RPG source member and creating a *PGM
object

Before you begin, you must complete [‘Exercise 2.5: Opening a source member for]
ledit” on page 14/ and if you were unfamiliar with the editing features of the
Remote Systems LPEX Editor then you must completd“Exercise 2.6: Reviewing|
[Remote System LPEX Editor features” on page 15

To make it easier for you, most of the RPG source is already prepared for you. You
have already opened the correct source member GETDATA in a previous exercise
using the Remote Systems view.
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Read through the source. It contains an F spec to access file CUSTOML3, which
contains the customer data keyed by customer number. The D specs define the
data structure CSTRUC that you pass back to your Web page and the CUSTNOI
variable that gets passed from the Web page to this program. As well the
FEEDBACK variable is defined as a 20 length character field.

The Entry parameter list is defined as:

* CUSTNOI field (this is the input parameter).

* CSTRUC structure (this is the data structure for the customer output data).
» Feedback field to indicate no success for file access.

The code you have to write here, fetches a customer record by chaining to the
file with the CUSTNOI that gets passed into the program.

To edit then create a *PGM object with RPG:

1. Add the code to get the customer record and check whether the chain was
successful.

1«
%

Insert code here ———————=——= >
c CUSTNOI CHAIN({e) CUSTOML3
c IF not (found(CUSTOMLS)
c EVAL FEEDEACE='CUS0001' 4+ CUSTNOI
C ELZE
C EVAL FEEDEACE='0"'
c ENDIF
cr Done with inserting code -—---—-—-—=--- >

Your coding is complete, so let’s create the program.

2. Click the Save | icon on the workbench toolbar to save the member.
3. Click the X in the Editor window title bar to close the member.

Be careful not to click the X on the workbench window title bar.

Chapter 2. Module 2. Creating an RPG program
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.5 Remote systens X “Neie el IIR=) |
2 | B3~
15 PRODDTL.*file.pf-cta 4]
| PRODINY *file pf-dta
| PRODLIST *file. pf-dta
| PRODSHOW, *file, pf-dt
| PRODUCT. *file.pf-dta
PRODUCTIF *file. If
-5 QUBLLESRC, *file.pf-sn
Eﬂ QDDSSRC, *file. pf-src
-[5h QRPGLESRC, *file. pf-sr
€ GETDASOL.rpgle
€, GETDASOLZ.rpgle
Bl G TOA el
0y GETD  GoTo »
-0y GETD

[§ qsvserT  OpenWith b -
1 (52:‘_5 #F  Browse With » {stem Details £3 Tasks]iﬁeri

&
¢

E-E-EFH-E-E

g AeC.*me = Copy
i @ ST.RCODE b Move...
. E-mv User libraries
3'] ';' iSeries Commands X Dekete...
| @8 iSeries Jobs

- >
-3 1FS Files ‘web Services
¥ Qshels 7 Find String...
4
_ | = Yerify
Elproperties £3 \\‘Bemote Ser 24 Verify (Prompt). .,
ﬂ Compile L
oty I Valuo Compile (Frompt) v [ CRTBNDRFG..,

» -
e User Actions (54 CRTRPGHCD. .

4. In the Remote Systems view, right-click the GETDATA member in source file
QRPGLESRC and click Compile (Prompt) > CRTBNDRPG on the pop-up
menu.

The Create Bound RPG Program (CRTBNDRPG) dialog opens.
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@ Create Bound RPG Program (CRTBNDRPG) x|
Program: > | GETDATA = MName

Library: = | WSSLABXX el Name
Saurce file: > | QRPGLESRC i Mame, QRPGLESRC

Library: > | WSSLABNY = Name
Source member: > | GETDATA i Hame
Source stream file:

=
Generation severity level; 10 0-20
Text 'description'; *SRCMBRTXT Zl Character value. ..
Default activation group: *ES =
Advanced Parameters
Compller options: > - I Add
*EVENTF Hemove(B)
Debugging views: > el
Replace program: > | *YES -
" Advanced(s) [™ all Parameters(g) ™ Keywords(7)
CRTENDRPG PGM(WSSLABX/GETDATA) SRCFILE(WSSLABYY/QRPGLESRC) SRCMER(GETDATA) CPTION(*EVENTF) DEGVIEW(*ALL) ;J
REPLACE(*VES)
[ ok | Restore defauits concel |

5. In the Debugging views list, select *ALL
6. Click OK to start to compile.

After compile, the iSeries Error List view is shown, listing all compile errors.
You may see only information and warning messages which means your

compile was completed and the program object was created

-
Remate System Details ] Tasks B EHE R A K= R0 [Series Error List |

s400a ]

Job 272659/STECKHAM/MELANIEICE submitted to job queue QBATCH in library QGPL.

OPTION(*EVENTF) DEGYIEW(*ALL) REPLACE(*YES)
Program GETDATA placed in library WSSLABXX. 00 highest severity, Created ol 03/23/05 at
15:07:22,

message severity that resulted was 00. The program creation date and time are 03/23/05 and
15:07:22,

CRTBNDRPG PGM(WSSLABKY /GETDATA) SRCFILE(WSSLABX/QRPGLESRC) SRCMER(GETDATA)

Cause ., .., : Program GETDATA was successfully created in library 'WSSLABYX, The highest

Command !Normal :i ] _ﬂ Prompt.. | F.*.unl

Al

7. Click the iSeries Commands Log tab to check that the compile was successful.

This log shows the Remote System Explorer job messages.
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If you get a message that there are errors in your program, go through the edit
compile fix cycle.

Fixing errors

In the error list view, check the errors:

1. Double-click the error.

This positions the cursor in the Editor window on the statement that is wrong.
Fix all errors.

Save the source member.

Go back to the Remote Systems view.

Right-click the member to run the CRTBNDRPG command.

Continue this cycle until you get a clean compile.

o g~ N

You have edited an RPG source member and created a program object.

Module recap

You have completed [Chapter 2, “Module 2. Creating an RPG program,” on page 7.|
You have learned how to:

» Start the product

» Set the default workspace

* Check the Remote System Explorer perspective is open

» Set up a new connection to an iSeries server

* Locate an RPG source file you want to edit

* Open an RPG source member with the Remote Systems LPEX Editor
» Highlight the tokens of your RPG source

* Show only comment lines in the RPG source

* Show all lines in the RPG source

» Display a format line

* Edit an RPG source member with the Remote Systems LPEX Editor
» Compile a program object

Now that you have created the RPG program, you can continue to [Chapter 4,
[“Module 4. Creating a Web project,” on page 41

|Skip|Chapter 3, “Module 3. Creating the RPG service program for your Web application|
l(optional),” on page 23] as you don’t need to do this set of exercises.
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Chapter 3. Module 3. Creating the RPG service program for
your Web application (optional)

|You do not need to do this module if you have done[Chapter 2, “Module 2. Creating an|
IIRPG program,” on page 7|

This module teaches you how to add the iSeries service program to your Web
application using the Remote System Explorer perspective. Remote System
Explorer provides a PDM like environment but with a GUI interface, and full
integration with all iSeries programmer tools in the product workbench.

In this module, you will:

 Start the product

» Set the default workspace

* Check the Remote System Explorer perspective is open

* Set up a new connection to an iSeries server

* Locate an RPG source file you want to edit

* Open an RPG source member with the Remote Systems LPEX Editor
* Highlight the tokens of your RPG source

» Show only comment lines in the RPG source

* Show all lines in the RPG source

» Display a format line

» Edit an RPG source member with the Remote Systems LPEX Editor
» Compile a service program object

If you haven’t used the LPEX editor before, you may want to spend some time
trying some LPEX editor features.

Exercises

The exercises in this module must be completed in order:

« [“Exercise 3.1: Starting the product” on page 24|

« [“Exercise 3.2: Opening the Remote System Explorer perspective” on page 25|
« [“Exercise 3.3: Creating a connection to the iSeries server” on page 27|
[“Exercise 3.4: Finding an iSeries source member” on page 28|

[“Exercise 3.5: Open a source member for edit” on page 29|

[“Exercise 3.6: Reviewing Remote System LPEX Editor features” on page 29
« |“Exercise 3.7: Editing a member and creating a service program module” on|

page 33|

Time required

This module will take approximately 30 minutes to complete.
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Exercise 3.1: Starting the product

Now go ahead and start the product.

On your desktop taskbar:

Sphere Development Studio Client For iSeries 6.0 #|ék  WebSphere Development Studia Client For iSeries

1. Click Start > Programs >IBM Rational > IBM WebSphere Developer for

iSeries Entry V6.0 > IBM WebSphere Developer for iSeries Entry

A dialog for workspace selection will appear asking you for the workspace
location, unless you used the product before and selected not to show this
dialog again.

[workspace Launcher x

Select a workspace

16M Rational Software Development Platform stores your projects in a directory called a workspace.
Select the workspace directory to use for this session.

Workspace: | Ci\Documents and Settings\Administrator|IBMrationalsdps, 0lwsslabixx ﬂ Browse. .. |

™ Use this as the default and do not ask again

The workspace contains all the information about your Development Studio
projects. You can accept the default or store the work related to this tutorial, in
a separate workspace.

To name the directory of the workspace as shown above, use the directory
name WSSLABXxX.

Click OK.

After a few moments of loading, the workbench opens, and the initial window
of the product appears on your desktop.
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@ Remote System Explorer - IBM Rational Software Development Platform

Rational Software Development Platform
h:.

You have just started the product, set the default workspace and now you are
ready to begin [“Exercise 3.2: Opening the Remote System Explorer perspective.”|

Exercise 3.2: Opening the Remote System Explorer perspective

Before you begin, you must complete [“Exercise 3.1: Starting the product” on page|

Check if the windowv title bar says: Remote Systems Explorer. If it does you are all
set. Skip the next steps and go directly to [“Exercise 3.3: Creating a connection to|
[the iSeries server” on page 27

To open the Remote System Explorer perspective:

1. In the workbench, check whether you have the Remote System Explorer
perspective already open. Look for the icon in the left taskbar of the
workbench.

2. If you see it, click the % RSE icon.
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File Edit Mavigate Search Project Run  Window Help

| OF Outline £2 = m
wutnne is not available.

3. Otherwise, click Window > Open Perspective > Remote System Explorer on

the workbench menu.
The Remote System Explorer perspective opens.

File Edit Mavigate Search Project Run  Window Help

v I AP IR J 5 E—ffliﬂRamota Syste...

"?.E outline 52 = [m
n{‘\?udlns Is not available.

w- N Power Linux...
i N,

~

{ BRremate ... 53\ Tasks]iserias..,l”i ~m

Root Connections IEQ—I | a2 -
Mame i Parent profile | Remote
Band Private Local
Clproperties 3\ |E & . v =0
Property I Value |
Marne Mew Connection
Mumber of chi... 7
Tyvpe &n expandable prompt fo...
| | i

|| #nexpandable prompt .. ection: New Connection |

You have checked that the Remote System Explorer perspective is open and now
ou are ready to begin [“Exercise 3.3: Creating a connection to the iSeries server”]|
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Exercise 3.3: Creating a connection to the iSeries server

Before you begin, you must complete [“Exercise 3.2: Opening the Remote System|

[Explorer perspective” on page 25|

To create a connection:

1.

3.

Click the plus sign + beside iSeries under New Connection in the Remote
Systems view.
Accept the default profile name.
@rew x|
Name personal profile
Uniquely name user profile | I
Welcome to Remate Systems, Connections can be sharable by the team or private to
you. Enter a profile name to uniquely identify you from your team members. You wil
decide for each new connection whether it is owned by the team profile or your
prafile,
Profile; | msteckh7tp
Finish Cancel
Click Next.
x|

Remole iSeries System Connection

Define connection information | I

Parent profile: |mstedd1?tp _'_I
Connection n 54003 \

Host name: s400a] ﬂ
Description: |

¥ Werify host name

< Back I Next > [@] Cancel |

In this exercise s400a is used as the name for the iSeries server. You will need
to use the name or IP address of your particular iSeries server.

Chapter 3. Module 3. Creating the RPG service program for your Web application (optional)
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4. Type a host name, for example, s400a in the Host name field.
5. The Connection name field will be filled automatically with the same entry.
6. Click Finish.

Your new connection appears in the Remote Systems view and you are ready
to work with objects on this iSeries system.

You have set up a new connection to an iSeries server and now you are ready to
begin [“Exercise 3.4: Finding an iSeries source member.”|

Exercise 3.4: Finding an iSeries source member

28

Before iou begin, you must complete [“Exercise 3.4: Finding an iSeries source|

You will see a list of libraries under Library list in the Remote Systems view. Now
you locate the source you want to edit.

To find an iSeries source member:

-4 New Connection

- = iseries. ..

| L. Connection created successfull
L @@y Windows...

P & Linus, ..

L .ﬁ Pawer Linux...

¢ Uk Unix. .

| BBy A%

- @ & Local... —

@-Ef Local

@2 work with objects. ..
. 19 work with members. ..
E l Library list
| B Q5Y52924.%ib.prod-sys
- B, QSYS.Hib.prod-sys
i Bem QSYS2 Mib,prod-sys
B QHLPSVS.Mlib.prod-sys

| DEMORES, *pgm.rpgle

: ¥ [5 GETDASOL.*pgm.rpgle 4
< | e

Note: If you don’t see WSSLABxx in your library list, then you need to add the
library. You can right-click the Library list and click Add Library List Entry
from the pop-up menu to add WSSLABXxx to your library list.

1. Expand your iSeries server. Use the same server that you have used to specify
the reference fields in the data structure.

2. Expand iSeries Objects by clicking the plus sign + beside it.
3. Expand Library List.
4. Expand the library WSSLABXX.
You will see all objects in this library.
5. Expand the source file QRPGLESRC.
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6. Scroll down to the source members in the expanded list.

You have located an RPG source member you want to edit and now you are ready
to begin [“Exercise 3.5: Open a source member for edit.”|

Exercise 3.5: Open a source member for edit

Before you begin, you must complete [“Exercise 3.4: Finding an iSeries source|
[member” on page 28

One shell source member is provided for you to use.

To open a source member for edit:
1. Right-click member GETDATAS.
2. Click Open with > Remote Systems LPEX Editor on the pop-up menu.

@ 12 PRODDTL.*file.pf-dta 4
=[5 PRODINY.*fle.pf-dta
5[5 PRODLUIST *file,pf-dta
&[5 PRODSHOW, *file, pf-dt
#-[5 PRODUCT, *file.pF-dta
-] PRODUCTIF *file,If
-5y QCELLESRC. *file.pf-sh
&[5 QDDSSRC *ile.pf-src
=-[5h QRPGLESRC *file., pf-sr
£ GETDASOL.rpale
Ok GETDASOL2.rpgle
O GETDATA.rpgle

M GETDATAS rpgle
0 GETDSSOL.rpak
- B mevennr KEDe

ms LPEX Editor

GoTa 4

Open With
Browse With

{4 CODE Editor

The Editor window opens and you are ready to write your program.

Tip: You can also double-click on a member to open the Remote Systems LPEX
editor.

You have opened an RPG source member for edit and now you are ready to begin
“Exercise 3.7: Editing a member and creating a service program module” on page]

53]

Now before you edit the member, if you have not worked with the Remote Systems
LPEX editor, go to[“Exercise 3.6: Reviewing Remote System LPEX Editor features”}

If you already know the LPEX editor, you are ready to write your service program, go to
|“Exercise 3.7: Editing a member and creating a service program module” on page 33

Exercise 3.6: Reviewing Remote System LPEX Editor features

Before you begin, you must complete [“Exercise 3.5: Open a source member for|

Before you start, here are some useful tips on using the LPEX editor. Let’s look at
some of the features of the LPEX editor, so you can later easily find your way
around and use them:
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ALT+L marks a line

ALT+U unmarks selection
ALT+D deletes a selected text
ALT+C copies selected text
ALT+M moves selected text
Enter inserts a new line

Highlighting specification fields

The LPEX editor highlights the Tokens (specification fields) of your RPG program
source, providing a separate color for each, improving readability. When you make
changes to a line, the token colors get updated only after you move your cursor off
the line.

To see how token highlighting works:

1.

2.
3.
4

Move the cursor to a Calculation statement.

Position the cursor to column 7 (right next to the C).
Type an asterisk (*).

Move the cursor off the line and watch what happens.

The line where you typed the asterisk (*) becomes a comment line and its color
changes accordingly.

| aeroatas.apaie x N ]
Line 43 Column & Replace 1 change
..... PHfoe 4t bbd bbbt Bt e e KEPUOTAS bbb
ooiz0o HNOMAIN ;l
001300 FCustoml3 if e K disk
001400 D* simple scruccure used for oucput paramecers
ooi1s500 DCSTRUC e ds extname (customl3:c
001600 D*
001700 D* Prototype for procedure getrecord
001800 D* if you don't specify extproc with lowercase name you
001200 D* GETRECORD in uppercase in Intericrtion Wizard for entr
oozooo L*
aoz100 Dgetrecord PR extproc (' getrecor
0Dzzoo D custnoi rl
o0z300 D myds likeds (cstruc)
002400 D feedback 20
oozs500 D
a0z 600 D* Start of procedure
0oz700 Pgetrecord I EXpOrt
onzso0o P* Procedure interface
ooz200 D pi
003000 I custnoil 7
003100 D custl likeds{catrue)
003200 D feedback z0
003300 D* end of procedure interface
o C*
dﬂﬁn ox sxal feedback="plank |
003600 C

Move the cursor back to column 7 and remove the asterisk (*).
Move the cursor off that line of code and the statement is tokenized.

The token highlighting changes to reflect that this is a non-commented C
specification.

Displaying types of lines
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Using the LPEX editor, it is possible to have only particular types of source lines

displayed at a time.

To display types of lines:
1. Right-click anywhere in the Editor window.
2. Click Filter view on the pop-up menu.
The menu items list the types of line selections that can be made.

3. Click Comments.

The Editor window now contains only those RPG statements that are

comments.

| Locemaniscae x NG s

Line 37 Column 1 Insert Z changes
Tos iR ool s s s s s e s i e 6
000100 *
ooozoo0 * Sample RPGIV program with procedure to access file
000300 L Thi=s program has to he created as a Jervice progrs
000400 * CRTRPGHMOD first then CRTSEVPEGH
Qooso0 % Used in WDT hands on LAB
0oos00n = Created by Claus Weiss
000700 *
0oos00 # F spec for file CUITOML3 keved by customer number
0oos00 ¥
oo1000 * J
DDlluD ERREETETRETY R4 2 A2 A R AR AR R AR A2 R AR AR AR R AR R R A RS RS SRS RS
a 001400 D* simple structure used for output parameters
001600 D*
001700 D* Prototype for procedure getrecord
Qoig00 D* if wou don't apecify extproc with lowercase hnawe you
001500 D* GETRECORD in uppercase in InterAction Wizard for enty
f oozooo D*
002200 D custnoi i
0DZ300 I myds likeds (zstruc)
002400 I feedback 20
00z 600 D* Start of procedure
00zZ800 P* Procedure interface
003000 I custnoi 7
003100 D custl likeds (zstruc)
003200 I feedback 20
003300 D* end of procedure interface
f oozaoo cw
Q03700 C*f ———— > add vour code after this statement <——————-
[} oossoo cr
004000 c#
B 004100 CF mmmm——— > your code end=z here <-
4 | 2l

4. Right-click anywhere in the Editor window.

5. Click Show all on
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Mew »

Prompt F4
Syntax Check Line

Ut

Copy e CErt
Paste Chrl+

Select »

Selected »

Deselect AL

Filter view 4
8

Source »

Wiew 3

b= Add ko Snippets...

Save

All statements types are displayed. In addition, the choices in the pop-up menu
can be used to include only control specifications, user subroutines, procedures
and others. The Filter Selection option under the Selected option in the Edit
menu allows the selection of only those lines containing a particular selected
character string.

Checking the syntax of a file

Syntax checking is available for RPG code, and by default will be active. The
syntax of RPG code is checked automatically when a change is made to a line, and
the cursor is moved off the line.

When errors are found, they are displayed following the statement with the error.
Keeping track of columns in a specification line

The format line is at the top of the Editor window, just above the first statement. A
format line is used to help keep track of the columns in a particular specification
line. The content of the format line can vary to reflect the particular type of
specification being keyed such as F specs, C specs, D specs and so on.

To display a format line:

1. Click a line or use the arrow keys and click the left mouse button to make a
line active.
The format line gets updated as a line gets focus.

You can move the cursor right or left with the arrow keys to go from character
to character, or with the Tab key to go from field to field. An indicator on the
format line moves with the cursor to show in which column the cursor is
positioned.
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You can select a format line for any specification you want.
2. Click Source from the Editor menu.
3. Click Select Format Line on the pop-up menu.

The Format Line Selection window opens.

@i Format Line x|

Select format line: |gH

| oK I Cancel I

Now you can start and create the service program.
4. Click OK.

You have highlighted tokens of your RPG source, shown only comment lines,
shown all lines, displayed a format line and now you are ready to begin
[3.7: Editing a member and creating a service program module.”]|

Exercise 3.7: Editing a member and creating a service program module

Before you begin, you must complete [“Exercise 3.5: Open a source member for|
ledit” on page 29 and if you were unfamiliar with the editing features of the
Remote Systems LPEX Editor then you must complete [‘Exercise 3.6: Reviewing|
[Remote System LPEX Editor features” on page 29
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To make it easier for you most of the RPG source is already prepared for you. You
have already opened the correct source member GETDATAS in a previous exercise
using the Remote Systems view. Read through the source. It contains an F spec to
access file CUSTOML3 which contains the customer data keyed by customer
number. The D specs define the data structure CSTRUC that gets passed back to
your Web page and the CUSTNOI variable that gets passed from the Web page to
this program. Also variable FEEDBACK is defined as 20 characters, to return
message id and customer number in case the customer record was not found.

The prototype for procedure getrecord with the parameters is defined as the:
* CUSTNOI field (this is the input parameter)

» CSTRUC structure (this is the data structure for customer data)

* FEEDBACK field (returns error or success)

Note: The external name is case sensitive. It has to match exactly what you
specified in the Web Interaction wizard.

The procedure interface defines the parameters in the same way as the prototype.
Inside the procedure after the procedure interface you need to add the RPG code.

Adding RPG code

To add the RPG code:

C*¥ > add your code after this statement <-————r—=——r—=-
(:t

(& CUSTNOI CHAIN(E) CUSTOML3

c IF Lfound (CUSTOML3)

C EVAL FEEDELCK='0"'

C EVAL custﬁ?cstruc

e ELSE

c EVAL FEEDBACK='CUS0001 ' + CU3ITNOIL

c ENDIF

C?‘

1
*

——————— * your cods Bnds hErE e

1. You do a CHAIN to the database and move the database fields to the local
procedure structure. If the database access fails, move the MSGID and
Customer number to the FEEDBACK variable.

Your coding is complete, so let’s create the service program module.
Creating the service program module

To create the service program module:

1. Click the Save | icon on the workbench toolbar to save the member.
2. Click X in the Editor window title bar to close the member.

Be careful, don’t click the X on the workbench window title bar.

3. In the Remote Systems view, right-click GETDATAS member in QRPGLESRC
and select Compile (Prompt) > CRTRPGMOD on the pop-up menu.
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o] CUSTOMS4. ¥file IF

Browse With

| Rename. ..

] CUSTOMLL e | i CoPY
] CUSTOMLE *ile Jf |+t Move...
.| cusTOMS1. e F 3¢ pelete, .,
| CUSTOMSZ, *File,IF
.| CUSTOMS3. *file.f ‘Wb Services 3

@[5 EVFEVENT.*flle.pf-d " Find String. ..

B L INYPRINT *file.prtf | ey

@ [E PRODDTL.*file.pF-dt

& [ PRODINY, *fle.pf-dt. £ VeriFy (Prompt)...

&[5 PRODLIST . *file,pf-d le 514 CRTBNDRPG

[+ 5 PRODSHOW. *file,pf '

PRODUCT . *file. pf-di User Actions 3 b

0] PRODUCTIF, *file, If

= é QCBLLESRC *file.pf-  Add To iSeries Project... j‘}"wnr_k R CnMe Cnmnds

¥ 5 QDDSSRC. *file pf-st Make Available OFfline asks| iSeries Table View | {Seties Commands L

=15 QRPGLESRC.*file.pf  Debuq(Service Entry) IFEVENT(GETDATA)
-0 GETDASOL.rpgle | Message
-0 GETDASOLZ tpg Compars With The name or indicator CUSTNG is nok refer
gﬂ I’Q Properties(H) The name or indil:ator CLISTNJ\_ is nat refer
B s L So.rpac T RISt The name or indicator REPMNO is not refere

B GETDSSOL.rpgle J H i RNFFOSL The name or indicator CONTAC is nak refer

The Create RPG Module (CRTRPGMOD) dialog opens.

@i Create RPG Module (CRTRPGMOD) | x|
Module: > | GETDATAS v| Name
Library: = | wasLaBkx vl Niara
Source file: > | QRPGLESRC | Mame, QRPGLESRC
Library: > | WSSLABXR =i Name
Source member > | GETDATAS ¥ Name
=l
Source stream file:
=
Generation severity level: 10 0-20
Text ‘description’; #SRCMBRTXT ;; Character value..,
Advanced Parameters
Compiler options: = - fidd
FEVENTF Remoye
Move down

| pebuaging viewss: > | I

Replace module: S R

[" Advanced(s) [~ all Parameters(s) [~ Eeywords(7)

CRTRPGMOD MODLILE(WSSLABXX/GE TDATAS) SRCFILE(WSSLABXX{QRPGLESRC) SRCMBR(GETDATAS) OPTION(*EVENTF) |
DBGVIEW(*ALL) REPLACE(*YES)

oK I Restore defaults Cancel I

In the Debugging views list, select *ALL
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5.

Click OK to submit the command.

After the compile the iSeries Error List view is shown, listing all compile errors.
You may only see information and warning messages that means your compile
was completed and the program module was created.

Remote System Detalls | Tasks FLE
s400a |

iSetigs Commands Log X

message severity that resulted was 10, The module creation date and time are 03/23/05 and _‘_I
15:10:52,

CRTRPGMOD MODULE{WSSLABXX/GETDATAS) SRCFILE(WSSLABXYQRPGLESRC)
SRCMBR{GETDATAS) OPTION(*EVENTF) DEGVIEW{*ALL) REPLACE(*YES)
Module GETDATAS placed in library WSSLABXX. 10 highest severity, Created on 03/23/05 at

15:12:24,

Cause ., .., Module GETDATAS was successfully created in library 'WSSLABYX, The highest
message severity that resulted was 10, The module creation date and time are 03/23/05 and
15:12:24.

w
%Cnrnmerld 'Normal :I I ﬂ Prompt., | ?’.unl

Click the iSeries Commands Log tab to check if the compile was successful.
This log shows the Remote System Explorer job messages. If you get a message
that there have been errors found in your program, go through the edit compile
fix cycle.

Fixing errors

In the iSeries Error List view, check the errors:

1.

o g~ wN

Double-click on the error.

This positions the cursor in the Editor window on the statement that is wrong.
Fix all errors.

Save the source member.

Go back to the Remote Systems view.

Right-click the member to run the CRTRPGMOD command.

Continue this cycle until you get a clean compile.

Creating a service program

To create a service program:

1.

2.

In the Remote Systems view find the GETDATAS module in library
WSSLABXX.

Note: If you don’t see the module, right-click library WSSLABxx and click
Refresh on the pop-up menu.

Right-click GETDATAS module and click Create > Service Program on the

pop-up menu.
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Remote Systems X

5

&l Go To ’
&) GETDATASC.*ma
| GETDSSOL.*modi E5] Show in Table

GETDSSOLC *mo
SLTPARTRFA *mi = Refresh
17 CELDIAL. *msaf Expand
Y *
S m:‘;f*n:g Collapse - hDetais 32 @‘E
-1 VRPGMSGF.*msg | Rename...
| ALLBACK *file.pf
| ALLSALES *file.pl = COPY
) APPSOLRCE. *file [l Faste
-] BYREGION. *file.I
6] CELDIAL, *file. dsy St
=) CUSPRINT *file.p. 3% Delete...
6] CLUSTING. *file.ds
CUSTOMER..*file.

o

E

B e

=

The Create Service Program (CRTSRVPGM) dialog opens.
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eate Service Program (CRTSRYPGM)

For the service program name, leave GETDATAS.

For the library name, leave WSSLABXX.

In the Export list, select *ALL.

Click OK.

Click the iSeries Commands Log tab at the bottom of the workbench.
You should see a message that the Service program was created.

No gk ow
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Remote System Detalls | Tasks ML EEC el -y - ROe. S

s400a |

WSSLABKX, The highest message sevetity that resulted was 10, The module :I
creation date and time are 03/23f05 and 15:12:24,

CRTSRYPGM SRYPGM(WSSLABXXIGETDATAS) MODULE(WSSLABXXIGETDATAS)
EXPORT(*ALL)

Service program GETDATAS created in bbrary 'WSSLAEXY,

Cause . ... .: Service program GETDATAS was successfully created in library
WSSLABXX. Recovery . .. Service program creation was successful, j

. Command ll‘dorrnal _1' ' ‘ﬂ (Fron

You have edited an RPG source member and created a service program object.

Module recap

You have completed [Chapter 3, “Module 3. Creating the RPG service program for|

[your Web application (optional),” on page 23| You have learned how to:

Start the product

Set the default workspace

Check the Remote System Explorer perspective is open

Set up a new connection to an iSeries server

Locate an RPG source file you want to edit

Open an RPG source member with the Remote Systems LPEX Editor
Highlight the tokens of your RPG source

Show only comment lines in the RPG source

Show all lines in the RPG source

Display a format line

Edit an RPG source member with the Remote Systems LPEX Editor
Compile a service program object

Now that you have created a RPG service program, you can continue to |Chapter 4,

[“Module 4. Creating a Web project,” on page 41)
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Chapter 4. Module 4. Creating a Web project

This module teaches you how to create a Web project and then supply the
information which the iSeries server will use for serving the business information
for this Web application. You will also learn about perspectives, J2EE settings, Web
projects, and the iSeries Web Tools Run-Time Configuration wizard.

In this module, you will:

» Access tools and views for iSeries Web application development

* Know the difference between a static Web project and a dynamic Web project

* Set up a dynamic Web project

» Define where the RPG program or service program resides on an iSeries server

Exercises

The exercises in this module must be completed in order.

» [“Exercise 4.1: Opening the Web perspective’]

« [“Exercise 4.2: Creating a dynamic Web project” on page 43|

« [“Exercise 4.3: Setting up the iSeries server information” on page 48|

Time required

This module will take approximately 15 minutes to complete.

Exercise 4.1: Opening the Web perspective

In this exercise you will use the Web perspective. This allows you to access tools
and views specifically related to Web application development. However, you are
still in the Remote System Explorer (RSE) perspective which gives you the tools to
do your iSeries programming tasks as you have discovered in the previous
module.

Perspectives

Before you go further, let’s review perspectives. Perspectives are a collection of
views and tools assembled to help different kinds of users to do their job when
they use the workbench. These workbench users will have different jobs (roles), for
example, one user needs to work with iSeries objects related to RPG/COBOL,
another user is dealing with Java programs, and another user with Web page
development. Each of these different user types will need different views of the
files/objects they are working with and they need different tools. The perspectives
present the user with a selection of specific views/tools geared towards the
different roles the users have. The workbench has many predefined perspectives,
like the:

» \Web perspective for Web developers.
* Remote System Explorer perspective for iSeries programmers.

You can also create your own perspective by using the Save Perspective as option
under the Window menu in the workbench, after you have modified a perspective.
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Now that you know what a perspective is you can go ahead with our exercise. You
are a Web developer in this tutorial and that is the reason you will select the Web
perspective. The Web environment provides its own perspective since it needs to
give its users access to unique views and tools targeted towards Web tasks. You
create a Web project in the Web perspective.

To open the Web perspective:

=10l x|
HRemote Systems 83\ Team = MRiseries Projects
£ 2] B o [BRremote System Explorer ||
= . Customize Perspective. .. \WebFacin
& l# ORDENTR'*:"’DQ’“"D'? Save Perspective As. ., e 2
- ) GETOATAS *modde  pecy pererective
+- 5] GETDATASC, *module Io -
[+~ 5] GETDSSOL. *module 5 saperspectwe‘
B~ 5 SLTPARTRFA, *mockile I oie S Etcpecives
& [ CELDIAL *msaf Navigation »
#-[ INVMSGF *msgf
w0 [ MYMSGF, *msgf Preferences

1. Click Window > Open Perspective on the workbench menu.
2. Then click Other on the pop-up menu.
The Select Perspective dialog opens.

@ Select Perspective _]5_]

ﬁ-DeI:ug

Tiseries Projects

(& J2EE

aj Java

©) .

W Java Browsing

ng Java Type Hierarchy

%ERemote System Explorer (default)

&

[~ Show al

| OK I Cancel

3. Select Web from the list.
4. Click OK.

The workbench will now show the Web perspective with the Project Explorer
view open on the left hand side.
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@& web - IBM Rational Software Development Platform = ]E‘I|5]

Fil= Edit Mavigate Search Project Run  Window Help
| @web

- THRemate Syste...

i _ LE“J.&:"

= =~ o

=5 7 ,‘\._.»1 =8
= A palette s not
$ S0 available,

terprise Appl s
+)- Lz Application Client Projects
B[y Cornector Projects
- L§ EJB Projects
- Ly Dynamic Web Projects
-0 Other Projects
L Web Services
L Databases h
1) Database Servers

e % . — — !
5% Outline £3 " Page Data b 51| = Properties £3 \\_i
#An outling is not available, | Ep o v
Property | Value
< |

22 | I/§ Entetprise Applications |

You have accessed tools and views for iSeries Web application development and
now you are ready to begin [‘Exercise 4.2: Creating a dynamic Web project.”

Exercise 4.2: Creating a dynamic Web project

on page 41.

Web projects hold all of the Web resources that are created and used when
developing your Web application. The first step to creating or importing a Web
application is to create either a static or a dynamic Web project. Static Web projects
are meant to contain only simple Web site resources, such as HTML files. Dynamic
Web projects are used to structure Web applications that will use more
complicated, dynamic Web technologies, such as JavaServer Page files, and
possibly data access resources.

Before iou begin, you must complete [“Exercise 4.1: Opening the Web perspective’]

To create a dynamic Web project:
1. Click File > New on the workbench menu.
2. Then click Dynamic Web Project on the pop-up menu.
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@ web - IBM Rational Software Development Platform = |I:I15|
| Flle Edit Navigate Search Project Run ‘Window Help

Close

Close Al

| Cirl4S

E Save Asi,

| HTML{HTML File
W ceve il Cer+shift+s (5 J5PFile

|+ Faces J5P File
© Page Template File

This starts the Dynamic Web Project wizard. The initial page of the wizard

Maye..,

opens.
& New Dynamic Web Project B _25]
Dynamic Web Project
Create a standalone Dynl;a;sr Web project or add it to a new or existing Enterprise Application project, |" o

Name: <| wsslabxxi )

Project lacation: IC:'I,Documents and Settings\Administrator\IBM\rationalsdp6.0lw  Browse... |

< Back I Mext > ” Einish I Cancel

3. Accept the default value in the Project location field.
This is where your project is stored in your file system.
In the Project name field, type WSSLABxx.

Click Show Advanced to specify the servlet version of your Web project.
Leave the Servlet version as 2.4.

Leave the Target server as WebSphere Application Server v6.0.

N o g ks
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@ New Dynamic Web Project x|

Dynamic Web Project

Create a standalone Dynamic Web project or add it to a new or existing Enterprise Application project, | e

hame: | wsslabiex

Praject location: |C:'I,Program Files\IBM|R ational\SDPY6.0ywsslabxxmar 23 wsslabx Erowss...l

I Hide Advanced <<

Servlet version: |2.4 ﬂ

LE=C -2 il | ebSphere Application Server w6.0

¥ add module to an EAR project.

EAR project: stslal:ochn.R j Ne,w...l

Context Root: | wisslaboce

[ Add support for annotated Java classes

ceac | Next> H Frish | Cancel

Click New next to the EAR project field.
Click Show Advanced to specify the J2EE version of your Web project.

These options allows you to specify the J2EE version for the Web project. If
you plan to use the WebSphere Application Server Version 6 only, then you
select J2EE version 1.4. If you are using previous versions of WebSphere
Application Server in your environment and are planning to deploy the Web
application to these versions then you use J2EE version 1.3 or 1.2 since these
earlier versions of WebSphere Application Server don’t support the J2EE
version 1.4. In this exercise you use the Web application in the WebSphere
Application Server (also known as the WebSphere Test Environment), which is
Version 6.0, so you use J2EE version 1.4 which is the default.

(I x|

Enterprise Application Project

Create an Enterprise Application project containing one or mare module projects,

Name: | wsslabxxEAR

Project location: | C:\Program FilesiIBMIRationall SDPY6, Diwsslabxmar23|wsslabx Bmws&.'.l

I Hide Advanced <<

J2EE wersion: [1.4 *
Targek server: |Web5phere Application Server v&.0 :] New... |
Finish Cancel
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10.

11.

12.
13.

14.

15.

16.

17.

18.

Leave the default value for the Name field.

A new or existing Enterprise Application project must be associated with your
new Web project for purposes of deployment.

The Enterprise Application project is new, so you typed the name of the new
project. When your Web project is created at the end of the wizard, the new
Enterprise Application project (EAR file) is also created. The default is an
Enterprise Application project named DefaultEAR located in the same
directory as your new Web project.

Leave the default value in the J2EE version list.
By default, the Web project’s J2EE level is set to the Workbench’s J2EE version.

Any new servlets and JSP files that you create should adhere to the latest
specification level available; previous specification levels are offered to
accommodate any legacy dynamic elements that you expect to import into the
project.

Click Finish on the Enterprise Application Project page.

Click Next.
The Features page opens.
(@ New Dynamic webprojeet x
Features
Select a Web Project feature. & feature can provide additional functionality For the Web Project., | @
Web Project features: Description:
e she 5 file) | |'select this feature to have & CSS file generated for = |
I Default synchroni n policy Far CVS reposil your praject
Beries Web Components Tag Library
ruts
[_|'WDO Relational database runtime
‘web Diagram
[=1-[] 35P Tag Libraries =
= o I ﬂ_l =
<tack [Cretd) [ Frsh | concel |
Leave the Default style sheet (CSS) check box selected to create a default CSS

file (called Master.css) for any HTML and JSP files included in the project.

Select the iSeries Web Components Tag Library check box as you want to
add iSeries fields and controls to the Web pages of your Web application.

Select the Struts check box as you want to create a project that uses Struts
technology.

Leave the Web Diagram check box selected to create a Web diagram in the
project.

Click Next to go to the Select a Page Template for the Web Site page.
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@& New Dynamic Web Project

Select a Page Template for the Web Site

Select a default page template For the Web site. This page template will be applied to new pages < > \

created using Web Site Designer.

@Use a default Page Template for the % site
Page template type
(¢ Sample page template " User-defined page template

Page Template File

Location! [

File name: I A_blue.htpl

Thumbnail;

.

A_blue.htpl A_agray htpl A_agreen.htpl

=

=

< Back @ Finish Cancel I

19. Select the Use a default Page Template for the Web site check box.
20. Click the A_blue.htpl thumbnail.
21. Click Next.

22. On the Struts Settings page, ensure that Create a Resource Bundle is selected.
If not, select the Override default settings check box and then select Create a

Resource Bundle for the Struts project.

& New Dynamic Web Project x|
Struts Settings
Select the initial settings For Struts [’I e
Override default setti

- oethngs

Struts yersion; Il.l '[

Default Java package prefix: Icon‘l.ihm.wsslab:<.\'

W Creste 3 Hesource Bundle

|_ Resourceoundie

| < Back I Mdext = | @J Cancel |

23. Click Finish to create the Web project.

Now you are back in the workbench and your new project and project files

appear in the Project Explorer.

Chapter 4. Module 4. Creating a Web project




=175 Enterprise spplications
122 wsslabxxEAR
L) Application Client Projects
2] 'i Connector Projects

# Lg EJB Projects

=L@ Dynamic Web Projects
LR PR

(e () Other Projects

L 2 Web Services

# Q Databases

#-L_[) Database Servers

You know the difference between a static Web project and a dynamic Web project
and have set up a dynamic Web project and now you are ready to begin
f4.3: Setting up the iSeries server information.”|

Exercise 4.3: Setting up the iSeries server information

Before you begin, you must complete [“Exercise 4.2: Creating a dynamic Web)|
[project” on page 43/

Before you can start creating your application, you will need to define where the
RPG program you will connect to later on in this tutorial is located. You need to
specify the iSeries server name and the user-ID and password to be used when
starting the job on the iSeries to run your program.

To set up the iSeries server:

1. In the Web perspective, right-click the WSSLABxx project in the Project
Explorer.
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# Lz Application Client Projects
# g Connector Projects
[#-L@ EJB Projects

ic. \Web Projects

=-L
e .
[# ([ Other Proj New
 Cg Web Servi
T =] C

[+ Databases okt
& [ Database - Paste

3 Delete
Refactor Alt+Shift+T #
Impart... 3
Export... »
7 Refresh
Close Project

| B2 outline 52
An outline is not 2 7 Tools Run-time Configuration .,

2. Click Specify iSeries Web Tools Run-Time Configuration on the pop-up
menu.

Tip: You could also use the ﬂ button from the workbench toolbar to open
the Run-Time Configuration wizard.

The iSeries Web Tools Run-Time Configuration wizard opens.
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@i iseries Web Tools Run-time Configuration N _)il

Configure Authentication
Specify how program call Web interactions should connect and authenticate H

" Prompt for user 1D and password
% sign on with specified values

Host name: | 54003

User ID: | WLABXK

Password: | R

¥ Enable password encoding

< Bach Finish Cancel
(Cext>) || | |

You use this wizard to specify how Web interactions that perform program
calls to an iSeries host should be connected and authenticated.

3. In the Host name field, type the name of the iSeries host where your program
is located, for example s400a.

4. Enter your user ID and password for the iSeries host in the appropriate fields.

You need to ensure that your User ID has been set up in a way that it
contains the correct library list. If not, you will have to use the table on the
next page to add a library to the library list when the job gets started to run
your program.

5. Enable password-encoding is selected by default. This option ensures that the
password appears in encoded format in the web.xml file. If you clear the
check box for this option, the password appears as plain text in the web.xml
file.

6. Click Next.

7. (Optional) If you need to add WSSLABxx to your library list, then type
WSSLABxx in the Library field and click Add.

8. Select the Display detailed run-time errors check box to see the details for
any errors that occur during the runtime of your Web application. This is
useful for tracing and debugging development errors that may occur.
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@i iseries Web Tools Runtime Configuration

Configure Runtime Environment
Specify the runtime configuration for program call of iSeries Web development tools

ol

-~ Runtime library list
Ubrary: | Add
Library [ Library Position | T |
Remaye
Move lp |
Move Do |
Current library: | *USRPRF =]
Initial command:

[|_7 Display detailed rurkime strorsl

—Session timeout procedure
Ubrarg: | Program object: |
Entry point: | Program type: ]"‘SR\PSM E|
- Message handling
Message resource: | comyibrmiwsslabuxiresources\applicationResources pr | Browse. ., |
v i
Message file name is invalid @
= Back I Next = I Eirish I Cancel I

9. Select the Use iSeries message file check box to retrieve error messages from

the iSeries host.
10. Click Browse to specify the iSeries message file.
11. Click the plus sign + beside s400a.
12. Click the plus sign + beside *LIBL.
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@ Message Resource Selection x|

Select a message file object,

& Work with libraries. ..
(=)0 s

i Cancel

13. Drill down to WSSLABXX > MYMSGF.*msgf.

@ Message Resource Selection x|

Select a message file abject,

| mymsar

& New Connection
=B s400a

20 Work with lbraries. ..
=50 *LIBL
[ mi, Q5VS2924,¥ib.prod-sys
B i QSYS.Mlib.prod-sys
-k Q5YS2.*lib.prod-sys
[~ QHLPSYS. *iib.prod-sys
[+ B, QUSRSYS. Hib,prod-sys
[E)ma wssLagssib.prod-usr
[ CELDIAL. *msgf

| CK I Cancel

14. Click OK.
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15. Click Finish to define authentication and run-time values for your host
program or procedure call to be made by your Web interaction in the Web
project.

You have defined where the RPG program or service program resides on the
iSeries server.

Module recap

You have completed [Chapter 4, “Module 4. Creating a Web project,” on page 41
You have learned how to:

» Access tools and views for iSeries Web application development

* Know the difference between a static Web project and a dynamic Web project

» Set up a dynamic Web project

» Define where the RPG program or service program resides on an iSeries server

Now that you have created a Web project, you can continue to [Chapter 5, “Module]
[5. Creating a Web application,” on page 55,
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Chapter 5. Module 5. Creating a Web application

This module teaches you how to create the interaction to use an input and output
page, and to create the servlet to invoke an RPG program to get data from the
iSeries database. You will also learn about interactions, Web input and output
pages and Program Call Markup Language (PCML). Finally you will learn how to
see the flow structure of your Web application.

In this module, you will:

» Start the Web Interaction wizard

» Create an input page that invokes the interaction

» Create an output page that displays the results of the interaction
* Get the program interface definitions

» Specify the input and output parameters

» Specify the input parameters to show on the input page

» Specify what data to show on the output page

» Specify what will happen when an incorrect customer number is entered
» Change the background color of the output page

* Make sure the customer number field is read only

* Know what Struts is all about

* View the flow structure of your Struts-based Web application

Exercises

The exercises in this module must be completed in order.

« [“Exercise 5.1: Invoking the Web Interaction wizard” on page 56|
[Exercise 5.2: Specifying the input and output page” on page 58|

« [“Exercise 5.3: Defining the iSeries GETDATA program invocation and|
parameters” on page 60|

« [“Exercise 5.4: Defining the iSeries GETDATAS service program invocation and|
parameters” on page 66|

[“Exercise 5.5: Defining the input page content” on page 73|
« [“Exercise 5.6: Defining the output page content” on page 75|

I

I

“Exercise 5.7: Specifying error handling” on page 77|
“Exercise 5.8: Enhancing the output page” on page 79
« [“Exercise 5.9: Ensuring the customer number field cannot be modified” on page]

87

« [“Exercise 5.10: Visualizing the flow structure of your Web application” on page]

g4

Time required

This module will take approximately 30 minutes to complete.
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Exercise 5.1: Invoking the Web Interaction wizard

During this exercise you will use the Web Interaction wizard to create the interface
description for parameters to be passed to an iSeries program. You will also
generate a Web page based on the parameters definition used by the program.
Some of the parameters will be defined based on existing iSeries database field
definitions.

To invoke the Web Interaction wizard:

2] L'_,.Q wsslabxxEAR
[z Application Client Projects
L4 Connector Projects

L@ EJB Projects

[=1-Lg Dynamic ‘Web Projects

GRS cslobcc|

+ 0 o N .

H-Lg Web

#-C Datal [i= Copy |1} Java Project
-0 Datal 7] paste 47 Package
¥ Delete @ Class
Refactor ale+Shife+T » &% Interface
Import... y i Source Folder
Expott... » 57 HTMLJHTML File
L . Refresh [+] 5P File
‘B outline & Close Project 4] Faces J5P File
\An outline is r Run Validation 7 Page Template File
& Specify iSeries Web Tools Runtime Configuration ... ‘. JavaScript Fils
Run b |$ CS5Fie
Debuig * (% Image Fils
Prafile »
Deploy ] Example...
Team

Chrl+MN

Compare With

1. Right-click WSSLABXxx in the Project Explorer.
2. Click New > Other on the pop-up menu.
3. Expand Web in the list.
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Select a wizard

iSeries Web Interaction Wizard

Wizards:

E;J = Wea

S5 File
Dynamic ‘Web Project
[3 Faces ISP File

fone Filker

k5T HTMLIXHTML File
& Image File

el JavaScript File

[&] 5P File

% Life-cycle Listener

: <>" Page Template File

: Serviet

Static Web Project

™ show &ll Wizards.

g

Cancel

Firish

Select Web Interaction from the list.
Click Next.

An interaction is the span between the submit of a request from the current

Web page to the post of a new Web

page. An interaction could be a simple

request to the HTTP server to load another page. In this environment an

interaction will be made up of a call to an iSeries program, waiting for the
return of the program with data and then invoking a JSP to show the next Web
page containing the data returned from the program.

First you have to give the interaction a name so you can reference it later on.

The Specify a Name and Location for your Web Interaction page opens.
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@ web Interaction - New I x|

Specify a Name and Location for your Web Interaction

Specify the name and location for the resources created For this Web Interaction. %’

Destination Folder: | fwsslabo:MrebContent Browse. ., |

[Web Interaction name: | custInguiry| [

Java package prefix: [com.ihm.wsslahxx

[V Use error page |.l‘errnr.jsp Browse. .. |

™ Invalidate session

[ Terminate iSeries connection

< Back. Mext > Firilsh | Cancel

6. Type custInquiry in the Web Interaction name field.
7. Click Next in the Web Interaction wizard.

The Specify the Input and Output Pages for your Web Interaction page opens.

You have started the Web Interaction wizard and now you are ready to begin

[Exercise 5.2: Specifying the input and output page.”|

Exercise 5.2: Specifying the input and output page

Before you begin, you must complete [‘Exercise 5.1: Invoking the Web Interaction|

[wizard” on page 56

The next page of the Interaction wizard asks for information about the Web pages
that are involved in this interaction. You have an input page that invokes the
interaction and an output page that displays the results of the interaction. The
output page shows in the browser at the end of the interaction. The wizard

generates both Web pages for you.

58  Development Studio Client: iSeries Web tools



@ web Interaction - custinquiry

Specify the Input and Output Pages for your Web Interaction

You can use previously designed input and output pages for this \Web interaction or you can have the wizard generate them. %

enerate input page I

(sererate cutput pages N

" Uss output pages:
JeustinquiryResults. jsp

[™ Generate inputfoutput pages using a page template

<peck [ met> | rur | cencel |
1. Click the Generate input page radio button.
2. Click the Generate output page radio button.
3. Select custinquirylnput.jsp and click Rename.
x|

W for the input J5P file

‘!inquirv.jsd ,

Cancel I

Enter inquiry.jsp as the new input JSP file name.
Click OK.

Select custinquiryResults.jsp and click Rename.
Enter result.jsp as the new output JSP file name.
Click OK.

Click Next.

The Specify the Input and Output Parameters for your iSeries Host Program
page opens.
You have created an input page that invokes the interaction and an output

© © N o gk

page that displays the results of the interaction and now you are ready to begin

“Exercise 5.3: Defining the iSeries GETDATA program invocation and|
parameters” on page 60|
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|T0 define the iSeries GETDATA program invocation and parameters go to [“Exercise 5.3]
|Defining the iSeries GETDATA program invocation and parameters.”]|

To define the iSeries GETDATAS service program invocation and parameters go to
[“Exercise 5.4: Defining the iSeries GETDATAS service program invocation and
[parameters” on page (%l

Exercise 5.3: Defining the iSeries GETDATA program invocation and
parameters

Before you begin, you must complete [‘Exercise 5.2: Specifying the input and|
[output page” on page 58|

The next page asks you to define the parameters you want to pass between the
Web pages and the iSeries program that processes the requests.

Here you will re-use the PCML program interface definition that was created when
you compiled your source member.

@ web Interaction - custInquiry x|

Specify the Input and Output Parameters for your iSeries Host Program

Use this page to define the input and output parameters For your iSeries host program. %

(+ Use an iSeries program or procedure Use a Java bean € o program cal

Program call definitions Add Program. .. I 400 Parameter, . | Add Structure.., |
ok |

Add Program
Program alias:

Program ohject;

=
*pG x|

Program type:
Entry point:

|
I
Library: |
I
I
I

CCSID of entry point:
Return bype: |vo&: ;]

Parse order: & I

Thread safe! IFaIsa L]
Source location: | :_j Yiew,,,

¥ Assaciate this program with e interaction

[Toport... || svnchvonize i |

< Back Next > I | Finish I Cancel

Getting the program interface definitions
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To get the program interface definitions that you want to call on the iSeries:

1. Click Import
The Import PCML dialog opens.

& Import PCML

~PCML File
You can import a standalone PCML file or directly from ILE COBOL or ILE RPG source code,

Select PCML File From: | E

| PCML file:

Select programs of structures to import Tree view of PCML file

1)

Select &l Deselect &l

€
(3
A

| oK I Cancel

2. Click the arrow on the Select PCML file from field
3. Select Remote/Local File System from the list.
The Browse For File dialog opens.
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@i Browse For File x|

Select a file

—1
e

s400a
S *UBL

+- B, Q5Y52924.Mlib.prod-sys
(-, QSYS.¥lib.prod-sys
-, QSYS2.*¥lib.prod-sys
[+, QHLPSYS. *ib,prod-sys
[+ =, QUSRSYS, *lib.prod-sys
- m, WSSLABK, *ib.prod-usr
el

#Fa JQDLS

o, JQFileSvr,400

2 [QNetware

65 JQNTC

s 1QOPeNSys

&5 JQOPT

]

Fl - (%)

Ef Local

oK Cancel

4. Expand the tree view of *LIBL and then look for the library WSSLABxx where
the RPG source is stored. You will use the source file to generate the PCML.

It should be in WSSLABXX/QRPGLESRC/GETDATA

@i Browse For File x|

Select a file

] WSSLABKAIQRPELESRC(GETDATA)

| CUSTOMSS. *file.If ]
] CUSTOMS4. *File,If

[5] EVFEVENT *file.pf-dta

(=) INVPRINT *file. prtf

5] PRODDTL. *file.pf-dta

5] PRODINY.*File.pf-dta

5]

[E] PRODLIST.*file.pf-dta
Tl PRODSHOW . *file.pf-dta
=l PRODUCT.*file pf-dta
.| PRODUCTIF. *file.If

56 QUBLLESRC *file.pf-src
55 QDDSSRC.*file,pf-src
5 QRPGLESRC. *file.pf-src
- GETDASOL.rpgle
-0 GETDASOLZ rpgle
S CETDATA. rpgle
-0 GETDATAS.rpgle
"€ GETDSSOL.rpgle ]

5 acwennT %l né Ak~

5. Select the correct file.
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6. Click OK.

7. The Import PCML dialog appears with a list of the program interface
constructs. You will import PCML directly from ILE RPG source code
GETDATA.

X
~PCML File
You can import a standalone PCML file or directly from COBOL ot ILE RPG source code,
Select PCML File from: [RemotejLocal File System =]
PCML file: C:\Documents and Settings\administrator|16M\rationalsdpé. Olwsslaby
Select programs or structures to import Tree view of PCML file
M <%, csTRUC RS CsTRUC

"

[ § cetoata @ £ GETDATA

[Gelectal] | Deselectal

* A data structure

* A call interface
8. Click Select All.
9. Click OK.

Specifying the input and output parameters

The Specify the Input and Output Parameters for your iSeries Host Program page
opens again, now containing the program description you just imported.
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&) web Interaction - custinguiry 1 LI

Specify the Input and Output Parameters for your iSeries Host Program

|, Chick OK to save changes. %

% Use an [Series program or procedure ™ Use a Javabesn f* Noprogram cal
Program cal definitions Add Program. .. I B Farameten | Add Stroctore) | I
o ! Y
=2 '% GITRUG Edit Parameter
E 1 GETDATA a
- Parameter nama: ICUSTNOI
& ¥ CSTRUC (CSTRUC) . '—j
&) FEEDBACK Data bypa: character >
Structure name: | 'I
Length: |'fr "I
Precision | v I
Count I
o —
Initial value: |
I~ Advanced.,,
Specify database reference field Speciy, Synchrorize I
Show database field definition SR
Import: Synchronize &l
(OS] comel |
<Back | e | g | caneal

1. Expand GETDATA in the left pane under Program call definitions.

The PCML information from the source file gets included in the right pane
and the parameters defined for this program appear.

2. Select the first parameter CUSTNOI.

3. In the right pane, change the Usage field from input & output to input to

indicate that this parameter is used to pass a value from the Web page to the
program.

4. Click OK
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b Interaction - custInguiry

In the left pane select the CSTRUC parameter.

In the right pane, change the Usage field from input & output to output,
indicating that this parameter is used to pass a value from the program to the
result Web page.

. Click OK.
Do the same for the FEEDBACK parameter.
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& web Interaction - custinquiry ) 5!

Specify the Input and Output Parameters for your iSeries Host Program

},, Clck OK to save changes. %

% Use an iSeries program of procedure " 1Use a Java bean " Mo program call

AddPruurm,.‘l Addperm...l Mdswch.rel

li Edit Program
|| Program aliss: [ceToATA
#|¥ CSTRUC (CSTRUC) Program objsct: [sETDATA oz |
[# FEEDBACK e G =
Program type: f*pam |
Entry point: |
CCSID of entry point: |
Return type: void =l
Parse order: C C
N Fetboncs ilJ
L
Thiead safe: [False |
Source Jocation: | =] | vew l
[p Al e e i I
Import... Synchrorize Al |
concd |
< Back | sk = ] Finish ] Cancel J

9. Now select GETDATA in the left pane under Program call definitions.
This will fill the right pane with program information.
10. In the right pane, select the check box Associate this program with the

interaction.
11. Click OK.
12. Click Next.

You have defined the program interface definitions and now you are ready to
begin [“Exercise 5.5: Defining the input page content” on page 73]

Skip the next exercise and continue with [“Exercise 5.5: Defining the input page content”]
_n page 73.

Exercise 5.4: Defining the iSeries GETDATAS service program
invocation and parameters

Before you begin, you must complete [‘Exercise 5.2: Specifying the input and|
[output page” on page 58|

The next page asks you to define the parameters you want to pass between the
Web pages and the iSeries service program that processes the requests.

Here you will re-use the PCML program interface definition that was created when
you compiled your source member.

66  Development Studio Client: iSeries Web tools



x|
Specify the Input and Output Parameters for your iSeries Host Program
Use this page to define the input and output parameters For your iSeries host program.
(+ Use an iSeries program or procedure Use a Java bean € 1o proaram call
Program call definitions Add Program. .. I Add Parameter., ., I Add Structure. ., |
. ﬁ#ﬂ J' =
Add Program
Program alias: |
Pragram ohject: | Browse... I
Library: I _'.l
Program type: | *PGM x|
Entry point: I Browse. .. |
CCSID of entry point: |
Return bype: |v0|a ;]
Parse order: % I
3
Thread safe: IFaIsa _'_]
Source location; [ =] ven. |
[¥ | ssatiate this program with Ehe interaction
[Toport... || svnchvonize i |
lo]s Cancel
< Back Mext = I Finish Cancel

Getting the program interface definitions

To get the program interface definitions that you want to call on the iSeries:

1. Click Import.

The Import PCML dialog opens.
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& Import PCML il

~ PCML File

You can import a standalone PCML file or directly from ILE COBOL or ILE RPG source code,

Select PCML File From:

PCML file:

Select programs of structures to import

Tree view of PCML file

Select &l

Deselect &l

[ o |

Cancel

2. Click the arrow on the Select PCML file from field.
3. Select Remote File System from the list.
The Browse For File dialog opens.

@i Browse For File x|

Select a file

®
[ -

s400a
S 5 HLIBL
+- B, Q5Y52924.Mlib.prod-sys
(- i, QSYS, *lib. prod-sys
-, QSYS2.*¥lib.prod-sys
[+, QHLPSYS. *ib,prod-sys
[ =i, QUSRSYS. *lib.prod-sys
- m, WSSLABK, *ib.prod-usr
el
#Fa JQDLS
o, JQFileSvr,400
o5 JQNetWare
65 JQNTC
&8s /QOpensys
gk (QOPT

- g JQSVSLIB
Ef Local

]

#

oK Cancel
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4. Expand the tree view of *LIBL and then look for the library WSSLABXx where
the RPG service program source is stored. You will use the source file to

generate the PCML.
It should be in WSSLABxx/QRPGLESRC/GETDATAS.

@i Browse For File x|

Select a file

I WSSLABKRIGRPELESRC(GETDATAS)

B 1] PRODLIST. *file.pf-dta a]
=[5 PRODSHOW *file.pf-dta
& [ PRODUCT *file,pf-dta
i-1)"] PRODUCTIF, *file.If
1[5 QEBLLESRC, *file. pf-src
[ [5h QDDSSRC. *file.pf-sre
] QRPGLESRC. *file.pf-src
E:, GETDASOL.rpale
By GETDASOLZ rpgle
. GETDATA.rpgle
| RN ceroatas. ool [l
| Uy GETDSSCL.rpgle
&[5 Q5YSPRT #file.pf-dta
- [3l SALES.*file.pf-dta

(5 WaSSCR *file savf
5] WrALBYX. *File.savF
Eg ABC. *menu.dspf

(&) STRCODE. *ustspc.usrdft r

m Gy

5. Select the correct file.

6. Click OK.
7. The Import PCML dialog appears with a list of the program interface constructs
contained in the PCML file.
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xI

~PCML File

You can import a standalone PCML file or directly from COBOL ot ILE RPG source code,

Select PCML File from: |Remate/Local File System =
PCML file: C:\Documents and Settings\Administrator| I6M\rationalsdps. 0iwsslabs
Select programs or structures to import Tree view of PCML file

M st cstruc of, CSTRUE

B ]
[4 © GETRECORD 4 GETRECORD

| I Select Al I I Deselect Al

G | e

* A data structure

* Acall interface
8. Click Select All.
9. Click OK.

Specifying the input and output parameters

The Specify the Input and Output Parameters for your iSeries Host Program page
opens again, now containing the program description you just imported.
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@ web Interaction - custInguiry -

Specify the Input and Output Parameters for your iSeries Host Program

1, Click OK to save changes.

% Use an [Series program or procedure

Program call definitions

ot !
- ofy, CSTRUC
L 1R (R}

[

En

A

™ Use a Javabean 1o program eal
Add program, .. | adi P | addsiiine. |
Edit Parameter
Parameter name: CUSTHOI
Data bype: character ‘l
Structure name: [ -]
Length: 7 -|
Count: [
Usage: [T - |
Initial value:
" Advanced...
Specify database reference field Hanize |
Show database field defintion
[[ox] conce |
<pack | et | men | cawel |

1. Expand GETRECORD in the left pane under Program call definitions.

The information from the PCML file gets included in the right pane and the
parameters defined for this program appear.

2. Select the first parameter CUSTNOI.

3. In the right pane, change the Usage field from input & output to input to
indicate that this parameter is used to pass a value from the Web page to the

program.
Click OK
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{8 web Interaction - custInquiry x|

Specify the Input and Output Parameters lor your iSeries Host Program

J, Thck OK to save changes. %

(% Use an iSeries program or procedure " Use a Javabean € Noprogratmcal
Program cal defintions Mdewm' Al Parameier., | A Striictne, |
ok | t
i o3, CTRUC Edit Parameter
= § GETRECORD n
A _CUSING o Parameter name: ICI.EII
. C—
S TEECEACY Diata type: structure >

Structure name: ||:STRUC x |

[ Advanced...
Specify database reference field Specify, Synchronze |
Import... synchwonie Al | Show databiase field defintion it
G|
< Back I | [ | Findst I Cancel |

In the left pane select the CUST1 parameter.

In the right pane, change the Usage field from input & output to output,
indicating that this parameter is used to pass a value from the program to the
result Web page.

Click OK.
Do the same for the FEEDBACK parameter.
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& web Interaction - custInguiry B x|
Specify the Input and Output Parameters for your iSeries Host Program
Use this page to define the input and output parameters For your iSeries host program. %
(% Use an iSeries program or procedure " Use 3 Java bean € ' No program call
Program calldefinitions AddProgram... | Add Parameter... | AddStructure...
& 2| -
gy CSTRUC Edit Program
- | s - —r ™
¢ CUSTNOI FipGrsen Saps =
@ |9 cusTi (CSTRUC) Program object: | GETRECORD
9
|9 FeeDBACK Lbrary: [*Li =
| Program type: | *sRyPEM =
Enkry point: |gdmcord Browss.., I
CCSID of ntry poink: I
Retum type: fvoud =
Parse order: CUSTL & |
FEEDBACK
k1
| Thread safe: [Fatse =]
e ot ! 5|1
™ Associate this program with the interaction
|
Import | symehronize st | [
QK | Cancel |
e “ f | cancel |

9. Now select GETRECORD in the left pane under Program call definitions.
This will fill the right pane with the program information.
10. Change the name of the service program to GETDATAS.
11. Select the Program type *SRVPGM.

12. In the right pane, select the check box Associate this program with the
interaction.

13. Click OK.
14. Click Next.

You have defined the program interface definitions and now you are ready to
begin [“Exercise 5.5: Defining the input page content.”|

Exercise 5.5: Defining the input page content

Before you begin, you must complete [“Exercise 5.3: Defining the iSeries GETDATA|
program invocation and parameters” on page 60| or [‘Exercise 5.4: Defining the]
iSeries GETDATAS service program invocation and parameters” on page 66

Now you need to specify which of the input parameters you want to see on the
input page for this interaction that gets generated by the wizard. This is easy in
this application since you only have the customer number input field to handle.
You also have the capability to enhance the page layout by changing colors of the
page background and changing the heading. The Design the Input Form page
contains a properties table that shows all input capable parameters, and a sample
of the Web page that will be created.
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& web Interaction - custInquiry ol = ll

Design the Input Form

Specify the page properties and the input parameters that the generated Web page will expose to the user for input. %
=
Input parameters: I .
E¢] custior Move up | wﬂm er
Move down
—, CUSTNOL |
Select All I
Deselect All I
‘nle Color
Form Bean Scope  request
Page | Fields | =

Changing the heading

To change the heading:

1. Click the field beside the Page Title property in the Property table and type

Customer Inquiry.

2. Press Enter to apply this change to the sample page.

Now you want to change the customer number field properties.
3. Click the Fields tab on the Properties table.

This opens the field properties for the selected field in the list.

Changing a field label

To change a field label:
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{8 web Interaction - custinquiry Zl

Design the Input Form
Specify the page properties and the input parameters that the generated Web page will expose to the user for input. %
=
] Customer Inquiry
F¢&] custhor Mave up |
=
4
Select Al
Desslect Al

Input Chaices:
Size! 7
hame in Session: CUSTHOT
Restore from Session:  False
Save bo Session: false
Get Browser Info.: False
Page | Fields | =

<Back|m:<t>| Hrshlcan:dl

In the left pane of the Design the Input Form page, select CUSTNOI.

Click the field beside the Label property, and type Enter customer number.
Press Enter.

Click Next to advance to the next wizard page.

Hw PR

You have specified the input and output parameters and the input parameters to
show on the input page and now you are ready to begin [“Exercise 5.6: Defining|
[the output page content.”|

Exercise 5.6: Defining the output page content

Before you begin, you must complete [“Exercise 5.5: Defining the input page]
[content” on page 73

Note: If you chose to work with a service program (GETDATAS) then you will see
the output parameters begin with the name CUSTL1. All the screen shots for
the remaining exercises show the parameters for the GETDATA program.

Now you can specify what data should be displayed on the output Web page
generated for you. In the right pane of the wizard you see a sample of the page
that will be generated. First, change the Input style of the output parameter
CSTRUC.CUSTNO. This will enable you to use customer number as an input
parameter to future features of your Web project.

To define the output page:
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@ web Interaction - custInquiry O

Design the Result Form

Specify the page properties and the output parameters that the generated Web page will display to the user as output,

Output page: result.jsp =]
= Result Form
B9 csreuc.repmo vl CSTRUC_CUSTNO: [
M9 cstruc.contac S =
B9 cstruc.crHonE CSTRUC_CUSTNA
B{g CSTRUC,CFAX Deselect Al CSTRUC REPNO:
B ¥ cstruc.canor =
B9 csruc.cary CSTRUC_CONTAC:.
BI¥ cstruc.ccount CSTRUC _CPHONE:
Eii{.g CSTRUC.CZIP CSTRUC_CFAX:
¥ CSTRUC,CZIPLO o
g;;; RS CSTRUC_CADDR:
CSTRUC_CCITY:
CETRUC CCOUNT.
Lroperty | veke 1| cstrUC CzIP:
Component Name: CSTRUC_CLS... =
Label: CSTRUC_CUS... CSTRUC_CZIPLO:
Data Type: g
Daa Tice: 51 || FEEDBACK
Input Choices:
Size: 7
MWame in Session: CSTRUC_CUS...
Save to Session: False
Message Controlier: False
Page | Fieds | |
o e cancel |

1. Select CSTRUC.CUSTNO.
2. Click the Fields tab.
3. From the Input Style list, select Text Entry.

By default all output parameters will be added to the Web page, but you don’t
want the data in the FEEDBACK parameter to be displayed.

Let’s go through the steps to erase the FEEDBACK parameter from the output
page.

Output page: result.jsp
Qutput parameters:

B9 cstrRuc.cusThO
[# cstRUC.CUSTHA
¥ cstrRuc.REPNO
M (¥ cstruc.contac
[9 CSTRUC.CPHOME
{9 cstRUC.CRax
(% cstruC.cADDR
M€ cstruc.carry
[¥ csTRUC.CCOUNT
B9 cstruc.czip

[¥ cstRuc.cziPLo
/%, FeeoBAcK

Mave up
Move down

Select All

i

Deselect all

4. In the left pane of the Design the Result Form, clear the FEEDBACK check box.
This will remove it from the Web page.
You will stay on this page to specify the error handling.
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You have specified what data to show on the output page and now you are ready
to begin [“Exercise 5.7: Specifying error handling.”|

Exercise 5.7: Specifying error handling

Before you begin, you must complete [“Exercise 5.6: Defining the output page|
[content” on page 75

Now you can specify what should happen in case a customer number didn’t match
the customer numbers in your database.

1. In the left pane of the Design the Result Form, select the FEEDBACK
parameter.

You will see the properties for this variable in the Properties table.

O «freepeack
Property I Yalue ] |
Component Mame: FEEDEACK
Label: FEEDEACK
Data Type: character(20)
Input Style: Label
Input Chalces:
Size: 20
Mame in Session: FEEDEACK
Save to Session: False =
Message Controller: ‘@
~ W
Page |Fields |

2. Locate the Message Controller heading in this Properties table.

@i Message Control Specification 5[

Message controller: |falsd £
' brue
e

Parameter Yalus I Message ID | ‘Web Component

Maveup

Maoye down

1 CK I Cancel

3. Click the field beside the Message Controller and set it to true.
4. Click New.
5. Set the Parameter Value to *0THER from the list.
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10.
11.

® Message Control Specification
Message controller: Itrue 'I

Ix

Web Component I ]

inquiry.jsp-*DEFAULT

Remove

Mave up

[l

Maye down

[ |

Cancel

Set the Message ID to *SELECT from the list.
This opens a Message Selection window.
Drill-down to s400a > WSSLABXX/MYMSGF > MYMSGF > CUS0001

@i Message Selection

x|

Select a message.,
If:USl'Ji.'Iﬂl: Customer number &1 not: valid | Property | walue ]
- z jin} CUsS0001
E[—lg Mew Connection, ..
Message hel
5 B s400as Seven?y . 0
!.ﬂ i‘,'ma . Text Customer number &1 not valid
5% Work with libraries. ..
&0 *LBL
P WssLAl

[ ]

<< Details Cancel

Click OK.

Leave the default value of the Web Component.

Click New.
Enter 0 as the Parameter Value.
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12.
13.
14.
15.

@i Message Control Specification R

Message controller: |true 'I

I

Parameter Yalus

*OTHER
0

| Message ID | ‘Web Component | Mew
Cusooot inquiry.jsp-*DEFALLT
WONE esul 5o "DEFALLT o Edt

Remave

Move up

Move down

i

I CK I Cancel

Press Enter.

Set Message ID to *NONE using the list.
Set Web Component to result.jsp-DEFAULT using the list.

Click OK.

Here is what you just did:
 If the return value of the FEEDBACK parameter is 0, display the customer

details in the result.jsp Web page.

* Any other return value in the FEEDBACK parameter, use the message 1D

CUS0001 in the specified message file, place the Customer number input in

the message substitution variable, and display the Web page inquiry.jsp

with the error message CUS0001.
The message handling is defined.

You have specified what will happen when an incorrect customer number is

entered in the customer number field and now you are ready to begin

[5.8: Enhancing the output page.”|

Exercise 5.8: Enhancing the output page
Before iou begin, you must complete [“Exercise 5.7: Specifying error handling” on|

page 77.

Next you enhance the look of the Web page.

To enhance the output page:

1. Click the Page tab in the Properties table.
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& web Interaction - custInquiry 1'

Design the Result Form
Specify the page properties and the output parameters that the generated Web page will display to the user as output. %

Output page: result. jsp
QOutput parameters:
¥ cstRuc.custio
[# cstRuc.cusTN
BE1¥ cstruc.Rerno
B cstruc.conTac
[ cstruc.crronE

Customer Details

CSTRUC_CTUSTHO:
CSTRUC_CUSTHA:

{3 s CSTRUC_REPNO.

=15 CSTRUC.CCITY CETRUC_CONTAC:

[¥ cstrRuc.ccounT CSTRUC_CPHONE:

[# cstruc.czip CSTRUC CFAX:

B[? cstruc.cziro —

1% Feepeack CSTRUC_CADDR:

CSTRUC_CCITY:

CSTRUC_CCOUNT:

CSTRUC_CZIP:

CSTRUC_CZIPLO:

HA

| |
E5ve &

< Back ] Nyt = ”TI Cancel I‘

Click the field beside the Page title and type Customer Details.

Click the field beside the Background Color and click the selection button on
the right side of the field.

The Color palette opens.
Select a light yellow from the Color palette.

Define Custom Colors »> [

0K | Cancel |

Click OK on the Color palette.

Click the field beside the Title Color and click the selection button on the
right side of the field.

Select Blue from the Color palette.
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8. Click OK on the Color palette.
You notice the sample page gets updated as you choose different properties.

If you don’t like the suggested color choices, go ahead and create your own
design.

You need to modify the labels of the fields that show up on the output JSP.
9. Click the Fields tab.

10. Select each field in the top left, and for each one, change the Label value to
the values described in the table below.

& web Interaction - custinquiry x|
Design the Result Form
Specify the page properties and the output parameters that the generated Web page will display to the user as output. %

.’ > 5915 | Customer Details
B1® csTrRuC.REPNO Mave down | - ]
B1® csTruC.CONTAC Selact Al | ‘m
E[# cstruc.crHONE tomer Name:
B(# csTRuc.crax Deselect A1 | presentative Number.
E(? cstruc.capte
BA® cstruc.caTy onfact.
BI# cstruc.coount Fhone Mumber:
|2 cstrRuc.czip P g {‘\\S
City:
| value | S
Property AL 4
Component Name: P 4 &
Data Type: s
Input Style: Teuk Entry
Input Choices:
Size: 7
Name in Session: CSTRUC_CUS...
Save ko Session: false
Message Controler: False
g—,@ =
< Back =t Cancel I
CUSTNO Customer Number
CUSTNA Customer Name
REPNO Representative Number
CONTAC Contact
CPHONE Phone Number
CFAX Fax Number
CADDR Address
CCITY City
CCOUNT Country
CzIP Zip

11. In the left pane of the Design the Result Form page, clear the
CSTRUC.CZIPLO check box. You don’t need to display this variable.

12. Click Finish on the Design the Result Form page.
The Interaction wizard creates the necessary files for your application:
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* The file custinquiry.wit is created in the project. This file reflects the data
you entered on the pages of the Web Interaction wizard for the interaction
you identified as custinquiry. To modify these settings, double-click on the
file to open the Web Interaction wizard.

* The default package under the Java Source folder contains the .java files
generated by the wizard.

e The classes folder under Web Content/WEB-INF contains the .class files
generated from the .java files that were created by the wizard.

You have enhanced the output page and now you are ready to begin [‘Exercise 5.9]
[Ensuring the customer number field cannot be modified.”|

Exercise 5.9: Ensuring the customer number field cannot be modified

Before you begin, you must complete [‘Exercise 5.8: Enhancing the output page” on|

Let’s make sure that the Customer Number field on your results.jsp page cannot be
modified.

To ensure the customer number field cannot be modified:
1. In the Project Explorer, expand WebContent and locate result.jsp.

-3 Web Site Navigation _a_]
e, Wweb Diagram

&3] E_m_ Deployment Descriptor: wss

488 Struts

# (# Java Resources

== WebContent

|- META-INF

#-{= theme

(= WEB-INF

| ngePassword. isp

-[E] error.jsp

B inquiry.jsp

L@ logon.jsp

01 messages.js

resulk.jspp

o e ISP

%3 wdtd00br . js

5 e = waslabuk,peml -
4| | B

2. Right-click result.jsp.

3
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[l Web Site Navigation
ey, Web Diagram
¥ 'gu Deployment Descriptor: wss
#1488 Struts
[ Java Resources
= (= WebContent
| E-(2 META-INF
B theme
#-(=> WEB-INF
[ changePassword.jsp
[ error.jsp
51 inquiry.jsp
- [& logon.jsp
1) ThesSages. js

- [5] timeout.jc  Mew

108 wdt400br pu—
b B wt:cl:—\hsne

3. Click Open on the pop-up menu.

This opens the result.jsp page on the Page Designer.

5] *result jsp &3 N Eﬁ
resul.isp - Untitled * Fl~ | iwd:WrextEntry » | Standard ~
3 =
Customer Details
foeresult label Customer_Number  gResasiy = =
tCSTRUC_CUSTNA Frrrmrr,
Woresult label Customer Name  © i
weresult label Representatve_Mumber : RUC_REFNO
“aresult label_ Contact RUC_CONTAC ;
#eresult label Phone_Number ‘CSTRUC_CPHONE } ¥|
Design | [ Source i Preview |
B Properties X Quickedt|servers|cm|mbaem|| k51 v =0
| Name: |csTRUC_custho | | -
TABLE
== | Input type: ® Text O Passworll O Hidden
™ | Size:
[ iweliwTextEntry  Initial state; DDisab[Ed@ead‘mW> )
- Daka Initial value: | |
- Bvents | Otientation:  |(Default) [l
il Tool tio: [ | %
4] | >

4. Select the Text Entry field of Customer Number in Page Designer.

Notice the Properties view of that
5. Select the Read-only check box.

Text field appears.

This prevents any modifications to the Customer Number.
6. Save your changes and close result.jsp.

You have made sure that the customer number field is read only and now you are

ready to begin [“Exercise 5.10: Visualiz

ing the flow structure of your Web)|

[application” on page 84
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Exercise 5.10: Visualizing the flow structure of your Web application

Before you begin, you must complete [“Exercise 5.9: Ensuring the customer numbetr|
field cannot be modified” on page 82.

A Web diagram is a view that helps you visualize the flow structure of a
Struts-Based Web Application. Because of the indirectness involved with a Struts
application, being able to visually see the application’s flow can help you to better
understand the application.

Struts

Before you create a Web diagram, let’s first look at what Struts is all about. First,
Struts is a set of Java classes and JSP tag libraries that provide a conceptual
framework for developing Web applications. The Struts technology is open source
and was developed as part of the Apache Software Foundation’s Jakarta project.

Second, Struts provides numerous, custom JSP tags that are simple to use but are
powerful in the sense that they hide information. The Page Designer does not need
to know much about form beans, for example, beyond the bean names and the
names of each field in a given bean.

Third, you can use the diagram editor to show all or part of a Struts application.
For example, suppose you have a three-part Struts application. One part handles
the login process, one part handles product inquiries, and a third part handles
product updates. In this case you could draw three diagrams to represent this
system, or you could draw the entire system in a single diagram. Because one
diagram can be included inside another, it would probably make more sense to
represent this Struts application using a set of three diagrams.

Now, that you know what Struts is, you can go ahead with this exercise.

You will now create a Web diagram that will show you the visual components of
the Web application you just created.

An empty Web diagram should have been generated for you during project
creation.

To create a Web diagram:

1. If you don’t see Web Diagram in the editor, in the Project Explorer view,
expand WSSLABXX.
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H-®

{8 struts

= WebContent

[#- (= META-INF
[#-(= theme

@ (= WEB-INF

~

~[&] error.jsp
~[& inquiry.isp
[ legon.jsp

&) result.isp
~[&] timeout.jsp

%) custInguiry.wik

[+ Java Resources

[ changePassword.jsp

) messages.js

=) wdt400br . js
=] wsslabxe,peml

B wiedahey mneml

=

2. Locate and double-click Web Diagram.

You will now see the Web Diagram in the editor.

Galeryl':'ﬁ

o=y A
L ) [_" E/ b d

92 Broject .., 52

"+ diagram,gph. X, N

)

L Connector Projects 4|
[+ EJB Projects
= [ Dynamic Web Projects
=l wsslabxx
[ web Site Navigati
", Web Diagram
[+ ‘g Deployment Descr
{8 Struts
[+ Java Resources
Bz WebContent
[+ (= MET&-INF
[+ = theme
H (= WEB-INF
@] changePasswi—
- [&] error.jsp
- [&] inquiry.jsp
- [&] logon.jsp
) messages.js
5] result.jsp
timeouk.isp ¥

A Web diagram is a file that
of a'web application.

Add Modes from the Palette)
(dlick on Palette, then click ¢

o Connect nodes by dickir
" on the bwo nodes to cor

Dauble click on any new noc
awizard to create the unde.

This note will disappear onc
For additional help, press F:

<

2

< | »
5% outline 32 . Y4 bl 1
L [=F

Now, let’s populate the

1. Locate inquiryjsp under WSSLABxx and then WebContent in the Project

Explorer.

from © to %3

[ TlProperties 52 . Quick Edk | Servers| 2

Web diagram:
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.
2 project ... 53\\__Gallery allER| “<. “diagram,gph X O
[cEe% ~
= L3 Dynamic Web Projects & |
12 wsslabso
[ Web Site Navigati
%@y, \Web Diagram
'z Deployment Descr
- {8 Struts
[+ % Java Resources .
[ (= WebContent EETR & Connection
= META-INF
# (= theme ) Undo Move Object
(= WEB-INF .
charigePassw W Reds
- [&] emor.gsp Edit Web Page
& gty sp Edit Other ’
& logon.jsp
L) messages.is 9 Delete
+-[&] result.isp
= ; Rename
-~ [&] timeout.jsp .
) wdt4aokr s Change Description
=) wsslabxx.pcm »
%) custInguiry wi
_ 9 il Y Drawal
2 wsslabxe mocml
4 f » 4
= = = lign »  Draw Selected
o= Outline 82 4 =!ml S
= Show Page in \Web Site Designer =
‘:: P | f =
]g Elpro § Diagram Settings le I Problarns’|_ a
_
2 Filter Settings | BB
Propel  Runon server..,
'] des Save
W brrage T s

4. Click Draw > Draw All From on the pop-up menu.

You will now see the custlnquiry interaction.
5. Right-click custinquiry and click Draw > Draw Selected.
6. Select the result.jsp check box

x
O  —=CustinquiryInputForm Scope: request
= = Global Forward
. [0  wehint.signon.prompt-->logon,jsp
| webint.changePassword. prompt-->changePasswo
=-[E= Local Farward
[  session_error-->timeout.jsp
-  wdt_error-->ervor.jsp

result-->result. jsp

< | H=

7. Click OK.

You should now see the graphical representation of the Web interaction that
you’ve created in a previous exercise.

86  Development Studio Client; iSeries Web tools



= 2
@9
inguiry.jsp Object
id = msg |
W@
i _ = result :
result.jsp

8. Save and close Web Diagram.

You have seen the flow structure of your Struts-based Web application.

Module recap

You have completed [Chapter 5, “Module 5. Creating a Web application,” on page|
[65] You have learned how to;

Start the Web Interaction wizard

Create an input page that invokes the interaction

Create an output page that displays the results of the interaction
Get the program interface definitions

Specify the input and output parameters

Specify the input parameters to show on the input page

Specify what data to show on the output page

Specify what will happen when an incorrect customer number is entered
Change the background color of the output page

Make sure the customer number field is read only

Know what Struts is all about

View the flow structure of your Struts-based Web application

You have created your Web application. Continue to |[Chapter 6, “Module 6

[Running the Web application,” on page 89|
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Chapter 6. Module 6. Running the Web application

This module teaches you how to test the Web application locally without
deploying the files in the Web project to the host server. Testing your Web
application locally includes using the iSeries Web Tools Run-time Configuration
wizard to specify the authentication and run-time values for every host program or
procedure call made by any Web interaction in the Web project. This is something

ou have already done in [Chapter 2, “Module 2. Creating an RPG program,” on|
page 7| or [Chapter 3, “Module 3. Creating the RPG service program for your Web)|
application (optional),” on page 23]

In this module, you will:

» Check the Web perspective is open

* Locate input page of the Web application

* Invoke the Web application to run in the WebSphere Test Environment
» Test the Web application

Exercises

The exercises in this module must be completed in order:
« [“Exercise 6.1: Opening the Web perspective’]
+ [“Exercise 6.2: Finding the Web application and running it’]

Time required

This module will take approximately 10 minutes to complete.

Exercise 6.1: Opening the Web perspective
To open the Web perspective:

1. Click the Web perspective £| icon, on the left taskbar of the workbench.

‘;I Remote Syste. ..

2. If there is no Web perspective icon, select Window > Open Perspective > Web
from the workbench menu.

You have checked that the Web perspective is open and now you are ready to
begin [“Exercise 6.2: Finding the Web application and running it.”|

Exercise 6.2: Finding the Web application and running it

Before you begin, you must complete [“Exercise 6.1: Opening the Web perspective.”|

To test your application locally using the WebSphere test environment:
1. In the Project Explorer, expand your project WSSLABXX.
2. Expand the WebContent folder.
3. Right-click inquiryjsp and click Run > Run on Server on the pop-up menu.
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o N
FEEE
[#- (= theme :[
(=% WEB-INF
~[&] changePass

~[& error.jsp
& (™
-5 logon.js  New :
o message
. (0]
—[&] result.is i
[ timeout | .
) wdtd00t -
B 1= Col
2| wsslabx: By
7 Paste

% custinguiry. -
| 57 waslabxxmr 3¢ Delete
- Other Projects
&L Web Services
[#-Lf) Databases
- Database Servers g Import...

4] | 7 Export...

Refactor Alt+Shift+T P

e < Edit | Servers | Console | Proble
| % Outine 22\ 4 " Refresh | | |l 3
S .Ti 3

fn outline is not available,
Run Yalidation |
ol unonsever.. |
[ SN S 1Y A

You will see a message to select the Server to run. You will run your
application in the WebSphere Test Environment. This is shown as WebSphere

Application Server v6.0.

@i server Selection x|
Define a New Server

Choose the type of server to create,
How do you want to select the server?

@hmse an existing server
(" Manually define a server

Select the server that you want to use:

B-& loEthast
-5 Websphere Application Server v6,0

Wiew By: |Host name *

Description: WebSphere Application Server w6.0

e&t server as project default (do not prompt)

ceack | mext> [[ Finish cancel |

4. Leave the default Choose an existing server radio button selected.
5. Make sure WebSphere Application Server v6.0 is selected under Select the
server type you want to use.
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6. Select the Set server as project default (do not prompt) check box.

7. Click Finish to configure and launch the server.

8. A Server Selection message dialog appears indicating the operation is in

progress.

Server Selection e
f;i;) Operation in progress. ., E%

[RuninBackground|  cancel | Detale >> |

After the WebSphere server has started, your Web application input page will

display in the workbench browser.

Daone

S|
Customer Inquiry
Enter customer number; 0010100
Reset
=

9. Type 0010100 as the Customer Number.
10. Click Submit.
This launches the generated output or result page.

a. If you see a Page not found error, go to the Servers view.
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d 3.5 Debug

Stop
§ Disconmect B Profile
= LI Publish |
Monitoring r
Restart Project L2

{i=; Add and remove projects. ..

Run universal test client
Restart universal best dient
Run administrative console

[Properties | Quick Edit m o MERrrstdEseneeesa: i
f— [] Create tables and data sources [
| Server | £ (% Run external admin script

i WebSphere Application Server v6.0  localhost

Ll | 2l
b. Restart the server instance. Then go back and try the Run > Run on

Server option again; the Server sometimes needs to be restarted to pick up

the changes.
You will see the Result page with customer data appearing in the workbench

browvser.
=
Customer Details
Customer Number: 0010100
Customer Name:; Meridien Electronics Limited
Representative Number: 43443
Contact: Alfredo Bayonne
Phone Mumber: 206-865-4027
Fax Number; 206-865-4037
Address: 10423 S E. 30th Place
City: Bellevue, VWA
Country: USA
Zip: 98007
Submit | Reset
i |
Dane

Next, test the message handling.

11. Click the ﬂ Back button in the browser to get back to the first page.
12. Enter a wrong customer number, for example, 9999.
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Customer Inquiry

Enter customer number | 9999
Reset.

=
Dane
13. Click Submit.
An error message appears.
=
Customer Inquiry
Enter customer number [3999
Submit | Reset

Customer number 99399 not valid

E
i,k |

This capability is generated by the Web Interaction wizard. Remember that
you specified something for the feedback field; you specified the message file
to be accessed if the feedback field contains a non 0 value; in this case the
feedback parameter will contain the message ID to be used for the error
message.

You have found and run the Web application.

Module recap

You have completed [Chapter 6, “Module 6. Running the Web application,” on page]
You have learned how to:

* Check the Web perspective is open

* Locate input page of the Web application

* Invoke the Web application to run in the WebSphere Test Environment
» Test the Web application

Now that you have run your Web application you learn how to debug your Web
application. Continue to |[Chapter 7, “Module 7. Debugging a Web application,” on|
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Chapter 7. Module 7. Debugging a Web application

This module teaches you how to debug a Web application. You will learn how to
set up the debug environment, use a service entry point, add and remove
breakpoints, display a variable, and view the call stack.

You will debug a Web application that invokes the iSeries GETDATA program.

In this module, you will:

* Recognize the features of the iSeries Integrated Debugger
» Start a debug session with service entry points

» Set breakpoints

* Monitor an expression

* Expand a thread to show every program, module, procedure and method on the
call stack at the current execution point

* Run the program to termination
Exercises

The exercises in this module must be completed in order.

« [“Exercise 7.1: Introducing the iSeries Integrated Debugger”]|

« [“Exercise 7.2: Starting a Debug session using service entry points” on page 96|
+ [“Exercise 7.3: Adding and deleting breakpoints” on page 98|

* [“Exercise 7.4: Displaying a variable” on page 99

« [“Exercise 7.5: Viewing the call stack” on page 100|

+ [“Exercise 7.6: Closing the debug session” on page 100|

Time required

This module will take approximately 15 minutes to complete.

Exercise 7.1: Introducing the iSeries Integrated Debugger

The Integrated Debugger is a source-level debugger that enables you to debug and
test an application that is running on an iSeries system. It provides a functionally
rich interactive graphical interface that allows you to:

* View source code or compiler listings, while the program is running on the
iSeries system.

» Set, change, delete, enable and disable line breakpoints in the application
program. You can easily manage all your breakpoints using the Breakpoints
view.

» Set watch breakpoints to make the program stop whenever a specified variable
changes.

* View the call stack of your program in the Debug view. As you debug, the call
stack gets updated dynamically. You can view the source of any debug program
by clicking on its call stack entry.

» Step through your code one line at a time.
» Step into or step over program calls and ILE procedure calls.
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» Display a variable and its value in the Monitors view. The value can easily be
changed to see the effect on the program’s execution.

» Locate procedure calls in a large program quickly and easily using the
Modules/Programs view.

* Debug multi-threaded applications, maintaining separate stacks for each thread
with the ability to enable and disable any individual thread.

» Load source from the workstation instead of the iSeries — useful if you don’t
want the source code on a production machine.

* Debug client/server and distributed applications.

The Debugger supports RPG/400® and ILE RPG, COBOL and ILE COBOL, C, C++
and CL.

In the following exercises you will be given the opportunity to learn about some of
the basic features of the Debugger.

You have been introduced to the debugger and now you are ready to begin
[“Exercise 7.2: Starting a Debug session using service entry points.”|

Exercise 7.2: Starting a Debug session using service entry points

Before you begin, you must complete [‘Exercise 7.1: Introducing the iSeries|
[Integrated Debugger” on page 95

In this exercise you will use service entry points to debug a Web application. The
service entry point feature is designed to allow easy debugging of Web
applications that invoke business logic written in RPG, COBOL, CL, or even C or
C++. The service entry point is a special kind of entry breakpoint that can be set
directly from the Remote System Explorer. It is triggered when the first line of a
specified procedure is executed in a job that is not under debug. Service entry
points allow you to gain control of your job at that point. A new debug session
gets started and execution is stopped at that location.

To start a debug session:

1. In the Remote System Explorer perspective, expand the iSeries server icon
(s400a) if not already expanded.

2. Expand iSeries Objects if not already expanded.
3. Expand the Library List if not already expanded.
If prompted, type your User-ID and password.
4. Expand the library WSSLABxXx if not already expanded.
You will see all objects in this library.
Now you will start the debug session and set a service entry point.
5. Right-click GETDATA.*pgm.rpgle.

6. Click Debug (Service Entry) Point > Set Service Entry Point on the pop-up
menu.

A message displays indicating the service entry point entry was successful.
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@i iSeries Debug Message _)_(j

i Service entry point is set successfully,

The service entry point can be refreshed through iSeries Service Entry
Paint{s) view if you recompile or update the program or service program later,

I Don't show this message again.

(===

7. Click OK.
8. Click the Web Browser tab to switch back to the Web browser.
9. Type 0010100 in the Enter customer number field.

10. Click the Submit button, which will invoke GETDATA*pgm.rpgle on the

iSeries host.

At this point, the Service Entry point is hit and the debug session is started.

Fil= Edit Source Comple MKavigate Search Project Run  ‘Window Help
[tie 0 %-0-@- - [®5 o Hoen e
I O e E8Remate Syste..,
I | Al e I \ " B
ot N y
ug ervers =Variables gakpo,.. | "4
%5Debug 2 8§ = 01| (69-variables &3 . Breakpo.. | > =05
- A=
0w % @ ks (l=® W =
@ _QRML_PRMCRY_CSTRUC = SPP:16F052:
& @ _QRML_PRMCPY_CUSTNOI = SPP: 16FDS:
—@El W;bSphere Application Server v6.0 [W‘el::_ - ) _QRNL_PRMCPY_FEEDBACEK = SPP:16F0=
S .La WebSphere Application Server v6.0 (' : _QRML_PSTR_CSTRUC = SPP:16F052491
£ G tmp [iSeres: Debug Job] @ _QRNL_PSTR_CUSTNOI = SPP:16F05249 v
=1 (1f¢ State: <stopped: Connection: iSerie— < | ’I
| E-4® Thread:! (STOPPED) =
i = GETDATA : GETDATA : GETD{ = e
- = on oy m.\m_,ﬂ_l o Ll_l

(" ™ P ™
O webBrowser | //GETDATA RPGLE N B2 Qutline Zé\\\ &8 =5

Line 1 Column 1 Repl -Press Refresh to update view
Wi T P
» 000100 5 =
000101 w
ooo102 x Sample RPGIL
000103 L Used in WDT
000104 * Created by ¢
000105 w
=
A ;I_'
|
Console L oM R 00 4 [Series Commands Log | Mamorvl =)

Ue| + % %) g |

Debug console not available for current sele::r.iun;]

-
«| | »

Debug Engine Command: I ;l
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Notice that it also opens an instance of the GETDATA source code in the
debug editor. You now have the access to debug this source.

Let’s look at some more debug features.

You have started a debug session with service entry points and now you are ready
to begin [“Exercise 7.3: Adding and deleting breakpoints.”|

Exercise 7.3: Adding and deleting breakpoints

98

Before you begin, you must complete [‘Exercise 7.2: Starting a Debug session using|
[service entry points” on page 96.

Breakpoints are markers you place in your program to tell the debugger to stop
your program whenever execution reaches that point. For example, if you suspect
that a particular statement in your program is causing problems, you could set a
line breakpoint on the line containing the statement, then run your program.
Execution stops at the breakpoint before the statement is executed. You can then
check the contents of variables and view the call stack, and execute the statement
to see how the problem arises.

You can only set breakpoints at executable lines. All executable lines are displayed
in blue. The easiest way to set a breakpoint is to right-click on the line in the
Source view.

To set a breakpoint:
1. Click anywhere on line 8.
2. Right-click and click Add breakpoint on the popup menu.

A dot with a check mark in the prefix area indicates that a breakpoint has been
set for that line. The prefix area is the small grey margin to the left of the

source lines.

Line 8 Colum 1 Replace Browse

I. ...FFilename++IPELSFRlen+LElen+iIDevice+. Keywords+++++-

w» 000100 * =

000101 *

000102 ® sample RPGIV program to access £ile CUSTOML:

000103 * Used in WDT hands on LAB

000104 * Created by Claus Ueiss

ooo10s i

ooo0i06 * F gpec for file CUSTOML3 keyed by customer numd
S~ 000107 FCUSTOML3 IF E K Disk

oooio8 *

Click on line 32.

Right-click and click Add breakpoint on the pop-up menu.

Click the Breakpoints tab in the upper right pane of the workbench.
In the Breakpoints view right-click the breakpoint for line 8.

Here you can manage your breakpoints. You can disable, or remove
breakpoints accordingly.

o ok~ w
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You have set breakpoints and now you are ready to begin [‘Exercise 7.4: Displaying|

a variable.”

Exercise 7.4: Displaying a variable

Before you begin, you must complete [“Exercise 7.3: Adding and deleting|
[oreakpoints” on page 98|

You can monitor variables in the Monitors view. Now you will monitor the
variable CUSTNOI.

To monitor a variable;
1. In the Source view double-click the variable CUSTNOI on line 22.
2. Right-click CUSTNOI.
3. Click Monitor Expression on the pop-up menu.
The variable appears in the Monitors view.

If you quickly want to see the value of a variable without adding it to the
Monitor, you can place the cursor on a variable to see its value in a pop-up
window. This works well for scalars, but not for arrays or data structures.

You have monitored an expression and now you are ready to begin m
[Viewing the call stack” on page 100,
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Exercise 7.5: Viewing the call stack

Before you begin, you must complete [“Exercise 7.4: Displaying a variable” on page|

The Debug view in the upper left pane, lists all call stack entries. It contains a tree
view for each thread. The thread can be expanded to show every program,
module, procedure and method that is on the stack at the current execution point.
If you double-click a stack entry that has debug data, the corresponding source
will show up. Otherwise the message No Debug data available appears in the
debug editor. In the Debug view, expand the stack entry of Thread:1 if it is not
expanded already, by clicking the plus sign + in front of it.

; ! Servers | I U ] |2 RS |t P
= ﬁ WebSphere Application Server v6,0 ['WebSphere v6.0 Server]

! . WebSphere Application Server v6.0 (WebSphere v6.0)

= ‘3% tmp [iSeries: Debug Job]

= @ State: <stopped: Connection: iSeries{TM) (TORAS4EF:3525)
= Lﬁ@ Thread:1 (STOPPED)

GETDATA : GETDATA : GETDATA
_QRNP_PEP_GETDATA | GETDATA : GETDATA
CallProgram : QZRCSRYS | QZRCRPC
main : QZRCSRYS : QZRCSRYS

_C_pep ! QZRCIRYS | QZRCSRYS
»| Process: 969346/QUSERJQZRCSRYS Program: GETDATA

You have expanded a thread to show every program, module, procedure and
method on the call stack at the current execution point and now you are ready to
begin [“Exercise 7.6: Closing the debug session.”]

Exercise 7.6: Closing the debug session

Before you begin, you must complete [‘Exercise 7.5: Viewing the call stack.”|

To close a debug session:
1. Click Resume on the Debug toolbar.
The session will stop at the first breakpoint on line 8.
2. Click Resume again.
The session will stop at the breakpoint on line 32.
3. Click Resume again.
4. Click OK on the Program terminated window.
Next, close the Debug perspective.
5. Right-click the Debug icon.
6. Click Close on the pop-up menu.

@i Debug - Web Browser - IBM Rational Software Development Platform =101 x|
Fil= Edit Mavigate Search Project Run  Window Help

|35 -0 ~Q-Q -~ | = 5 [ | %5 Debug_ (d Web
\ @Ramnh#

5awers| = ﬁ]f\farlablaslooﬁraakpolnts 32 S
i ‘ &0 - % v show Text

7. Switch to the Remote System Explorer perspective to remove the Service Entry
Point on GETDATA.*pgm.rpgle.
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8. Drill down to s400a > iSeries Objects > Library List > WSSLABXX >
GETDATA . *pgm.rpgle

9. Right-click on GETDATA.*pgm.rpgle

10. Click Debug (Service Entry) > Remove Service Entry Point on the pop-up
menu.

You have run the program to termination.

Module recap

You have completed [Chapter 7, “Module 7. Debugging a Web application,” on
You have learned how to:

* Recognize the features of the iSeries Integrated Debugger
» Start a debug session with service entry points

» Set breakpoints

* Monitor an expression

* Expand a thread to show every program, module, procedure and method on the
call stack at the current execution point

* Run the program to termination

Now that you have debugged your Web application, you learn how to create an
informative error page using Page Designer. Continue to [Chapter 8, “Module 8|
[Adding an error page,” on page 103/
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Chapter 8. Module 8. Adding an error page

This module teaches you how to create an informative error page using Page
Designer for when a customer enters an incorrect customer number. This way, the
customer won’t just be given an error message, but will have a more informative
and helpful response from the Web Application, which is easy to customize. You
will also learn how to add the error page to your existing Web application using
the Web Interaction wizard and to use the RSE perspective to modify the program
or service program to call the error page. In this module, you will:

» Create an error page using Page Designer

* Change the Web interaction to use the new error page
* View the result of adding flow control to the Web application

Exercises

The exercises in this module must be completed in order.

« [“Exercise 8.1: Creating the flow control page”|

« [“Exercise 8.2: Modifying your Web interaction” on page 105|

« [“Exercise 8.3: Testing the new error page” on page 111|

Time required

This module will take approximately 20 minutes to complete.

Exercise 8.1: Creating the flow control page

First you need to create the error page using Page Designer.

To create the error page:

1. In the Web Perspective, expand your project and drill down to the Web
Content folder.

]I' ‘))1

o {8 Struts
¥ (# Java Resources
WebContent
MET&-IN
o = theme

(= WEB-INF -

& [éDeplaymentDescrlﬁf:-:n.l;imt;\-lssl-ab).c-x 3

= Copy

A pdetE
available

d ' Project...

[ Java Project

g changeP | - Paste 5 Package
[lel SOrISE 5 pelete .
[&] inquiry.j: X (= class

[ logen.jst  Refactor Alt+Shift+T » €8 Interface
=00 MESSAQE

[&] results.j g2g Impart...

o[z timeout,  a Ex
: uu]
T

& Source Folder

| Folder

i " | wsslabx: ", Refresh
) custInguiry s

o7 HTMLIKHTML File

2. Right-click the Web Content folder and click New > JSP on the pop-up menu.

The New JSP File page opens.
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@ New ISP File x|

ISP File )
Specify a name and location For the new 15P file. ‘ ; \

Folder: ] Jwsslabso'WebContent Browse. .. |

Markup Language: ]HTM. _:I
Options: " Create from page template %

[ Create as J5P Fragment

[T Uise 201 Style Syntax

Maodel: IN::ne
Generate a new blank J5P page.

K 131 K

[~ Configure advanced options

< Back I Mext > |@ Cancel I

3. In the File Name field, type RecordNotFound.
4. Click Finish.
The Page Designer automatically opens.
Your window will look like this.

- =
8@ RecordiiotFoundjsp X, N =

RecordhotFound.]...cordiotFound.jsp El~ | Booy - | standard ~

Place content here

Design | Source | Preview |

5. Click on the words Place content here. and change it to something like Sorry,
there is no record for that customer number.

Press Enter.

Type Please check the number and try again.
Highlight the words try again and right-click.
Select Insert Link on the pop-up menu.

© ® N o
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The Insert Link window opens.
10. Click Browse next to the URL field.
11. Click File on the pop-up menu.
The File Selection window opens.

_ioi
Select a file:

E-{== wsslabix
== WebContent

# (= META-INF
- theme
- (= WEB-INF
~0) messages.js
93 wdt400br js
: changePassword. jsp
-[5] error.jsp

-[a] l0goORN,. ISP
i RecordiotFound. jsp
results.jsp

~[&] timeout,jsp

: =| wsslabxx.pcml

'ﬂ‘ Cancel I

12. Select inquiry.jsp.
13. Click OK.
14. Click OK in the Insert Link dialog.

You have completed creating the flow control page.
15. Save and close the file.

You could spend more time customizing this page, but for the purpose of this
exercise you will leave the page as is.

You have created an error page using Page Designer and now you are ready to
begin [“Exercise 8.2: Modifying your Web interaction.”

Exercise 8.2: Modifying your Web interaction

Before you begin, you must complete [“Exercise 8.1: Creating the flow control page”|
on page 103.

Now you need to change the Web interaction to use the new error page.

To modify the Web interaction:
1. Expand your project WSSLABXxx if not already expanded.

2. Right-click custinquiry.wit and click Open With > iSeries Web Interaction
Wizard on the pop-up menu.
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-[E] struts-bean.tid 4|
|Z] struts-config.xml
[Z] struts-html.td

[} struts-logic.tid

[Z] struts-nested.tld
[Z] struts-template.tid
[Z] struts-tiles.td

@ web,xml
changePassword. jsp

v EBrror.jsp

Inguiry.jsp

logon.jsp

messages.js
RecordNotFound. jsp
~[e] resulkt.jsp

@ timeout. jsp

2 wot400br. js

| wsslabsee, poml

EICEIEIEIED :

i 8% wsslabxx.mp
) Other Projects
L5 Web Services

[ L Databases

New »

# - Database Servers = ] Text Editor
5% outiin 52 . Page Date |- Paste | System Editor
An outling is not avaiable, 9% Delete | =| In-Place Editor
Default Editor

Refactor Alt+Shift+T »

The Web Interaction wizard opens.
The name and location of your Web interaction are already specified.
3. Click Next to add a new output page.

Specify the Input and Output Pages for your Web Interaction
You can use previously designed input and cutput pages for this Wb interaction or you can have the wizard gererate them,

Page preview:
" Geserate inpat pags I
' Use input pages:
Jinqury.ssp

(7 Ganerate oitpit pages
1% Use output pages:
Jresuk. 1sp

IT | Gerierate Input oot pace< (ing = oege tamol s

<Back net> [ Fmen |

4. Next to the result.jsp section, click Add.
The Output JSP window opens.
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@i Output I5P x|

wo[E] error.jsp
[ inquiry.jsp
[ logon.jsp
~[B] results.jsp
[ timeout.jsp

() | o |

5. Select RecordNotFound.jsp.
6. Click OK to add the new output page.

{8 web Interaction - custinquiry N x|
Specify the Input and Output Pages for your Web Interaction
You can use previously designed input and output pages for this Wb interaction or you can have the wizard generate them, %
Page preview:

S

7 Ganerate outpit panes
1% Use output pages:

Jresuk jsp
RecordhotFound. jsp

I7 | Gererate Input foutort pace< (sing = pege tamolats

o | () | ] _cmen |

7. Click Next in the Web Interaction wizard.

You will re-use the Feedback parameter to control which page the Web
Interaction will send next after it performs its action; the result.jsp or the
RecordNotFound.jsp. So you don’t have to add another parameter or change
the parameters, you just change the values the feedback parameter returns
depending on whether a customer record was found or not found.

8. Click Next since you don’t need to define the program interface.
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This opens the Input Parameters page.

9. Click Next again since you don’t need to change any input parameters.

10.
11.
12.

corresponding eutput Fields on your 'Web page.

This opens the Output Parameters page.

& web Interaction - custinquiry 5]
Map and Link the Output Parameters to the Dutput Fields
Link the parameters in your program to the Fields on your Web page. The value of the output parameter in your program is passed to the

»

Output parameters:
[# ecstruc.cusTio
| cstRuc.cusTia
[# cstRuCREPND
[ cstruc.conTac
| csTRuC.cPHONE
|2 cstRuc.crax
[ cstruc.capor
[# csruc.cay
[# cstRuc.coounT
|# cstruc.cap

2 e IPLO

| Unlink.

Property | vaoe
Data Type: character{20)
Name in Session; FEEDBACK
Save bo Sessan: falsa

Flow Controller: fals
Message Controller: @

Parameters

I Output page fields:

[ Feids | [E75 reeition

CSTRUC.CUSTNO
CSTRUC.CUSTNA
CSTRUC.REPNG
CSTRUC.CONTAC
CSTRUC.CPHOME
CSTRUC.CFRAX
CSTRUC.CADDR,
CSTRUC.CCITY
CSTRUC.CCOUNT
CSTRUC.CZIP

result.jsp-CSTRUC_C...
result,jsp-CSTRUC_C...
result, jsp-CSTRUC_RE...
result jsp-CSTRUC _C...
result jsp-CSTRIJC_CP...
result,jsp-CSTRUC_CF..,
result, jsp-CSTRUC C...
result jsp-CSTRUC C...
result jsp-CSTRUC C...
result. jsp-CSTRUC_CZIP

19| fRecordNatFound. jsp
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Select FEEDBACK under the Output Parameters list.
Change the Message Controller property to false. Click OK.
Select FEEDBACK under the Output Parameters list again.

Now a Flow controller property is added to the Properties table.




_Property | vaiue |
Data Type: character(20) _Froperty | vaiue |
HName in Sessian; FEEDBACK
s to Ses ¢ false
Fiow Controter: @
Message Conkroller: False %
< Back (e Finish Cancel
13. Change the Flow Controller property to true.
The Flow Control Specification dialog opens.
@i Flow Control Specification k _)_<_j
Flow Contraller: Itrue TI
yalus | output 35p | new |
| results.jsp
*OTHER {RecardNotFound. jsp Remove |
Maove up |
Move down |
| OK I Cancel I

14.
15.
16.
17.

18.

19.

& web Interaction - custInquiry

Map and Link the Output Parameters to the Dutput Fields

Link the parameters in your program to the Fields on your Web page. The value of the output parameter in your program is passed to the
corresponding cutput Fields on your Web page,

x|

»

Output parameters:
[ cstruc.custio
| cstRuc.cusTia
[# cstrRuc.REPNO
[ cstruc.contac
| cstRuc.cPHONE
|8 cstruC.cRax
[ cstruc.canor
[# csuc.cay
[# cstRuc.coounT
| estruc.czip

Q

= GIPLO
Gy

Lir Uinlink.
| I Output page fields:
Parameters | Fields | Bl (@] result.jsp
CSTRUC.CUSTNG  result.jsp-CSTRUC C... 18] fRecordhotFound. sp
CSTRUC.CUSTNA result.jsp-CSTRUC C...
CSTRUC.REPNO result, jsp-CSTRLIC_RE...
CSTRUC.CONTAC result jsp-CSTRUC_C...
CSTRUC.CPHONE result jsp-CSTRUC _CP...
CSTRUC.CFAX result, jsp-CSTRUC _CF..,
CSTRUC.CADDR, result,jsp-CSTRUC_C...
CSTRUC.CCITY result jsp-CSTRUIC C...
CSTRUC.CCOUNT  result,jsp-CSTRUC C...
CSTRUC.CZIP result. jsp-CSTRUC_CZIP

The value =0THER is already in the Value field for the Zerror.jsp.
Click the /error.jsp field to change the Output JSP page.
Select RecordNotFound.jsp from the list.

Click New.

This creates a new flow condition. The default page is result.jsp.
The value 0 is already in the Value field with result.jsp in the Output JSP

field.
Click OK.
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This will set the flow control such that if the value of Feedback is 0, then the
program will output the customer information to the result.jsp page and
display it.

However, if the customer number doesn’t exist in the database, the Feedback
value will be something else other than 0, and instead of displaying a message
near the input field, it will show the user the RecordNotFound.jsp page for a
more helpful response.

20. Click Finish on the Output Parameters page to apply your changes to the
Web Interaction.

& web Interaction - custinquiry 1]
Map and Link the Output Parameters to the Dutput Fields
Link the parameters in your program to the fields on your Web page. The value of the cutput parameter in your program is passed to the
corresponding cutput fields on your 'Web page.,
Lars L. lfl *
Qutput parameters: | I Output page fields:
[# cstruc.custio Parameters | Fieids | [= 3] result.isp
[£ cstRuc.cusTia g’“UECUS“‘Ng resti.jsp-CSTRUC_C... 3] RecordhotFound. jsp
e e CIRUCREND  renk p COTRUC RE..
1 CSTRUC.CONTAC CSTRUC.CONTAC resul.jsp-CSTRUC_C...
¥ csTRuC.CPHONE CSTRUC.CPHONE result.jsp-CSTRIUC_CP...
|# csmruc.crax CSTRUC.CFaAX resuk jsp-CSTRUC_CF..,
[? cstRuc.cacor CSTRUC.CACDR, result, jsp-CSTRIUC_C...
o CSTRUC.CCITY result.jsp-CSTRUC C...
[f; CSTRUC,CCITY CSTRUC.CCOUNT  resut,jsp-CSTRUC C...
Es‘; CSTRUC. COCUNT CSTRUC.CZIP result fsp-CSTRUC CZ]
@ csTRUC.CZIP
[® cstruc.czipLo
| FeeDBACK
Property | vae J
Daka Type: character(20) | _Property | vaive I
Name in Session; FEEDBACK
Save bo Sessan: falsa
Flow Controller: true
<o | oo |[ComY ] o |

You have changed the Web interaction to use the new error page and now you are
ready to begin [‘Exercise 8.3: Testing the new error page” on page 111)
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Exercise 8.3: Testing the new error page

Before you begin, you must complete [“Exercise 8.2: Modifying your Web)|
interaction” on page 105 |

Now that the flow control is in place, if you enter a wrong customer number,

=
Customer Inquiry
Enter customer number | 9999
Reset |
X
Dons

you will get the error page instead of a message.

-
Sorry, there 1s no record for that customer number.
Please check the number and try agamn.
v
Daone

Now follow the instructions below to run the modified project on the WebSphere
Test Environment to see the result of adding flow control to your Web application.

The server should still be running from the last time you ran the Web application.
Every time you make a change to the Web application, you need to restart the
server to pick up the changes.

To restart the server:
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d 3.5 Debug

Stop
¥ Disconnect £ Profile
=L Publish

Monitoring .4

Restart Project >

{i=; Add and remove projects. ..

Run universal test client
Restart universal best dient
Run administrative console

ijmp-erties Quick Edit m ¢ Reconmest- debug process i
[je—— [] Create tables and data sources [

L | 2

1. Click the Servers tab to open the Servers view.

2. Select the server instance. Right-click and click Restart on the pop-up menu.
The server instance should restart.

3. In the Web perspective Project Explorer locate the Web Content folder, and
right-click inquiry.jsp.

= project... x "=l
I DES -
(= theme 4]
B (2= WEB-INF
~[&] changePass
& error.isp
&
-5 logon.js  New “
) message
& resul.is o
& tmeout IR ¥
% w400t
Y wsslabx: GoRy
; 5 custInquiry, - Paste
! 57 waslabxxmr 3¢ Delete
[#-[1 Other Projects
&L Web Services Refactor Alt+Shift+T *
[#-Lf) Databases
[#-L_f Database Servers g Import. .,

4 | % Export...

o S Edit | Servers | Console | Proble
o7 Qutline I3 4 " Refresh i
‘An outline is not available, | S

Run Yalidation |

[ S 13

4. Click Run > Run on Server on the pop-up menu.

You have viewed the results of adding flow control to the Web application.

Module recap
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You have completed [Chapter 8, “Module 8. Adding an error page,” on page 103
You have learned how to:

* Create an error page using Page Designer
» Change the Web interaction to use the new error page
* View the result of adding flow control to the Web application

Now that you have added an error page to your Web application to handle
incorrect customer numbers, you can learn how to customize your input page.
Continue to [Chapter 9, “Module 9. Enhancing the input page using Web tools,” on|

|Eage 115.|

Chapter 8. Module 8. Adding an error page 113



114  Development Studio Client: iSeries Web tools



Chapter 9. Module 9. Enhancing the input page using Web
tools

This module teaches you how to use the Web tools in the workbench to update the
input page of your customer inquiry Web application. The input page named
inquiry.jsp is one of the files created by the Web Interaction wizard. This page is
very plain. You will learn how to use Page Designer and some related Web tools in
the workbench to add some color to the input page, as well as add some pictures
to make it a more interesting Web page.

In this module, you will:

* Locate the Web application input page and start Page Designer
* View the title of the input page

* Add a style to the input page

* Preview the new style for the input page
» Start WebArt Designer

* Create a logo

* Resize the logo

» Save the object as a WebArt object

» Save the object for a Web page

* Place the object on the Design page

* Add a company name to the input page
* Add an image to the input page

* Add a marquee to the input page

* Apply color to certain areas of text

Exercises

The exercises in this module must be completed in order

+ [“Exercise 9.1: Opening Page Designer” on page 116|

« [“Exercise 9.2: Working with page properties” on page 117

+ [“Exercise 9.3: Linking a cascading style sheet to the Web page” on page 118|
« |“Exercise 9.4: Designing and adding a logo” on page 120|

[“Exercise 9.5: Adding a heading 1 tag to the page” on page 129

« [“Exercise 9.6: Adding a picture to the page” on page 131]

« |“Exercise 9.7: Adding moving text to the page” on page 132|

[Exercise 9.8: Changing the text color” on page 136|

Time required

This module will take approximately 30 minutes to complete.
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Exercise 9.1: Opening Page Designer

The first step is to locate the inquiry.jsp file and to start Page Designer. In Page
Designer you will link the page to a cascading style sheet that comes as a sample
with the workbench.

To open the Web perspective:
1. In the workbench, open the Web perspective:
You should now have the Project Explorer in your workbench.

l:lﬁ'l'

|7|

‘g ow
£

%o, Web Diagram -

[+ 1251 Deployment Descriptor: wsslabx:
B g8 Struts
[+ Java Resources
- WebContent

(= META-INF

(= theme

(= WEB-INF
~[&] changePasswaord,jsp
[ error.jsp

-

[ logonjsp  New 5
') messages

- “e"’"j"‘m
[ results.js Open W £

2. Expand the WSSLABxx web project.
3. Expand the Web Content folder.
4. Right-click inquiry.jsp and click Open on the pop-up menu.

inquiry.jsp - Untitled El~ | Booy - | standard ~

5ustomer Inquiry

+ First message
+ Second message
+ Third message

i Source ] Preview |
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The Page Designer appears in the upper right pane of the workbench and
shows the inquiry.jsp page as the Web Interaction wizard created it.

Make sure that you are on the Design page in Page Designer.
5. Click the Design tab.

You have located the Web application input page and started Page Designer and
now you are ready to begin [‘Exercise 9.2: Working with page properties.”|

Exercise 9.2: Working with page properties
Before iou begin, you must complete [“Exercise 9.1: Opening Page Designer” on

Next you move the form down.

To work with page properties:
1. Click underneath the heading Customer Inquiry.

inquiry. jsp - Untitled * El=| p- Standard ~

E

Customer Inquiry

Iy

_________________________________________________________________________________________________

+ First message
» Second message
+ Third message

Design | Source | Preview |

2. Press Enter number of times as shown above.

3. To change the page properties, right-click the background of the inquiry.jsp
page in Page Designer.
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of! it
a Copy
B et
3¢ Delete

Save

Insert 4
JEP »
7 Insert Link... CtrHQ

Page Properties. ..

Style R ]

Embedded Document 4

Switch Active Document,

| Properties Ctri+Al+Enter
Layout Made »

=] Run to Line CErl+R.

E_ Addta Snippets, |,

| Edit Events

4. Click Page Properties on the pop-up menu.
The Page Properties window opens.

x
Page Information | Meta Info | J5P Tags |
Page title: Customer Inquiry
Base URL:
Default target: | :l
(eete - S0 10646(Unicode{UITF-G1I® =]
OK I Cancel I

This window allows you to change some of the page properties.

For example you could change the title. When this page is shown in a browser,
the Window title bar of the browser will display Customer Inquiry.

You have viewed the title of the input page and now you are ready to begin

[“Exercise 9.3: Linking a cascading style sheet to the Web page.”|

Exercise 9.3: Linking a cascading style sheet to the Web page
Before iou begin, you must complete [“Exercise 9.2: Working with page properties”|

on page 117,

Now you will add a style to the input page. You can use a style that is used in
your company or you can use one of the sample style sheets that are provided in

the product.
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To link a style sheet to an input page:

|B 11

[l
Al A S OF =
& Q- | ™5 |

5[ @ web

Eﬂnemote Syste,.,

-
Project Explorer

Gallery 23

8

%\_ »1 l._—lE

| Image

| Standard =

[ HTML Tags

ok b o+ ok

|

Al

.

= Form Tags
l@ J5P Tags

— i5eries W...

Eistruts HT...

[ Struts Be..,

B struts Lo,

[irage Te...

[ web sie...

Fosta #

2 Web
Service

[@E®
Session

‘
ﬁgnfswcegpre\wiewi

bean

T Properties 52 . Quick Edit | >

aa"

=l

Mo attribute is available,

=1y Relational
Record

[ Relational
Record List

& JavaBean

| attributes

/
Qutine iswlesﬁ;_"* Thumbnals 9 72 =]
Style Sheet Files =l

creamsodal;

| .géz | wsslabooe/WebContent finguiry. jsp l

Click the Gallery tab, if the Gallery view isn’t already displayed.
Click the Style Sheet icon in the Gallery list.

w N e

You should see thumbnail icons of all the styles available as shown above.

In the thumbnail view, scroll down to the bottom, until you see style sheet
denim001.css in the list, or select a style sheet that you like best.

Click the thumbnail picture of denim001.css.

Hold the left mouse button down and drag the mouse cursor to the Page
Designer window.

I3
The cursor will change from this shape Y , to this shape*& . When the

latter cursor shape appears in the Page Designer window then, let go of the
mouse left button.

After a short while the Style sheet properties will be applied.
Click the Preview tab.

Click the Thumbnails tab in the left bottom stacked view in the workbench.

You will see the colors in the page have changed to the style sheet definitions.
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& *“inguiry,jsp. X

Ty

inquiry.jsp - Customer Inquiry *

L’_ |

Yinquiry. button. submit I Yeinguiry.button.reset |

» Firstmessage
« Second message
« Third message

Design l Sourc@

8. Click the Design tab to get back to the Design page.

You have added a style to the input page and previewed the new style for the

input page and now you are ready to begin [“Exercise 9.4: Designing and adding a

Exercise 9.4: Designing and adding a logo

Before you begin, you must complete [‘Exercise 9.3: Linking a cascading style sheet]

[to the Web page” on page 118

Now that you have the overall Web page look specified you will use the WebArt
Designer to create a Logo that you then will add to this page.

Starting the WebArt Designer

To start the WebArt Designer:

@& web - inquiry.jsp - IBM Rational Software Development Platform = |EI|E
File Edit Toobar Insert ISP Format Table Frame Page Navigate Search Project Run  Window

Help Launch External Web Browser 3
|55 - B | 2 spell Check... Shift+F7
|BpzrustoermESe = 3|94 Validate HTML Syntax

o 4 Conwvert ko XHTML. .,
[EE | | @ O

¢ n Web#rt Designer
" AnimatedGf Designer

& tinguir
ina

Pro]uct Explorer | [ Gallery 52 =0
Image

1. Make sure the Page Designer is in focus.
2. Click Tools > WebArt Designer in the workbench menu.
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The WebArt designer opens.

e Untitled - WebSphere Studio WebArt Designer ;IQ[EJ
File Edit Yiew Object Tools Help
losEd (2R xE v - oz« (e e
e mye
8 x nD - el |———= 4
45 Webért & Gallery | =
D @ ® [ 7
Button Rollover  Shapes AN\ M -
Text: J\J @ -
-] &~ |
& A
aaad—o U/
A
SR
For Help, press the [F1] key. | [ A

The WebArt Designer shows the Template Gallery on the left, where you find
samples of logos, buttons, rollovers, images and more. The large white area in
middle of the dialog is the canvas that is used to work with objects that you
want to create or change. Now you will create a logo from scratch.

You could also select one from the template gallery as the base for your own
logo.

Creating the logo

To create the logo:

1. Click the Create Logo button above the canvas or click Object > Create Logo.
The Logo Wizard opens.
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Logo Wizard (Specify Text - 1/4) B 35.'

P

|BM -
(I SSLABxY ) :I
Zf?{_'ﬁ
o |wesis
— Fant
Font name:
Font size: -
Line ] 03 Character I DE]
spacing: % spacing: 2l %
~Shle————————  —Alignment
old  Left
talic enter
™ Shikethrough < Right
™" Underine —Divection
W Antisiias [~ Vertical

2. In the Text field, type your company name and in the next line in the Text
field, type WSSLABxx.

3. In the Font name list, select Comic Sans MS.
4. In the Font size list, select 46.
5. Under Alignment, select the Center radio button.

Notice in the upper right corner of the dialog, a sample of the logo as
specified is displayed.

6. Click Next to go to the next page of the wizard.
The Select Color page opens.
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Logo Wizard (Select Color - 2/4) ) .}S.I

< Back Next > Cancel |  Hep |

7. Select the gradation type button; the middle one of the three type push
buttons.

Tip: The other buttons select color types: solid and textured.

8. Select beer from the colors available, or any other color you like best, just
scroll through the list to find a gradation you like.

Tip: You can change the colors by clicking the Others button on this dialog
and create you own gradation.

9. Click Next to go to the next page of the wizard.
The Select Outline page opens.
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Logo Wizard (Select Dutline - 3/4) ‘El

~ Options
Edgevidh ~ ——————
Edge color; -l
Tanspaency: S =

Bulge for edas: IE- il

< Back Next > Cancel | Hep |

10. Select the Seal outline from the list, or any outline you like best.
11. Click Next.
The Select Text Effect page opens.

Logo Wizard (Select Text Effect - 4/4) ‘EI

Type:
i i i
alafal) =
; C i (e fifysy

Shadaw Cut Emboss

7] |

~ Options

Embossment
strength:

Embossment
direction:

<Back [ Fiish | Cancel | Hep |

12. Select the Emboss text effect, or one that you like best.
13. Click Finish.
You return to the WebArt designer window.
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Resizing the logo

To resize the logo object on the canvas:

1. Click the logo object to select it.

2. Move the cursor to the rectangle at the right bottom corner of the object; watch
the cursor changing shape.

3. Drag the rectangle up and to the left so the object becomes smaller.

Saving the object as a WebArt object

Now you need to save this object. First save it as a WebArt object. This allows you
later on to work with the object again in WebArt Designer, but you can’t use that
format for your Web page.

To save this object:

1. Click File > Save Canvas As on the WebArt Designer menu.

The Save Canvas As window opens. Make sure you see the WebContent folder

in the Save Canvas As window.

Save in:

) WebContent

N
1

_IMETA
| Itheme

I WEB-

File name

Save as |

:ﬂ Desktop
A= My Computer
= Local Disk (C:)
] Documents and Settings
] Administratar
] 1BM
Ca rationalzdpB.0
1 weslabxs

) waslabss
= New Volume [D:)
@ Compact Dise (23]
My Metwork Places

] &pplication Data

ebC.ontent

& @ e E-

21X
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Save in: I (=7 WebContent :I o e

CIMETA-INF
ithems
) WEB-INF

File name: Im_',llagn Save I
Save astype: |webdst files [%mif) | Cancel |

I™ | nclude Canvas

4
2. In the File name field, type myTogo.
3. Click Save.
Now you need to save the object in a form that can be displayed on a Web
page.

Saving the object for a Web page

To save the logo for a Web page:
1. Click the logo object on the canvas.
2. Click File > Save Wizard for Web from the WebArt Designer menu.

The Save Wizard opens.

Save Wizard (Specify Objects) - 1/3 ] 3_]

Specily the objects you want to save.
@ave the selected objects
(" Specify the objects Specify...

¢ Back Next > Cancel | Hebp

3. Click the Save the selected object radio button.
4. Click Next.
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The Select File Format page opens.

Save Wizard (Select File Format) - 2/3

5. Click the GIF radio button.
6. Click Next.
The GIF Format page opens.

Save Wizard (GIF Format) - 3/3
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7. Click Finish.
The Save As window opens.

2|

Save in: I I WebContent

~| « & ek E-

CIMETA-INF
itheme

) WEB-INF

%] denimbo3bu, gif

File name: Imylngd

Save I

Save astype: | GIF files [*.gif

=l Ca

ncel
&

Make sure the directory is pointing to the Web Content directory in the

workspace where your Web project is located.
8. In the File name field, type mylogo.
9. Click Save.
Close the WebArt designer.
10. Select File > Exit from the menu.

You return to the workbench in the Web perspective and see the Project

Explorer.
Placing the logo on the Design page

To place the logo on the Design page:

1. Make sure you switch from the Gallery view to the Project Explorer.

2. Expand the WSSLABxx Web project.
3. Expand the Web Content folder.

T T, calery | =0

8% v
[ 48 Struts ﬂ
[+ 8 Java Resources
ISRESY \WebContent [\\\S
(= META-INF
# [ theme
- (= WEB-INF

~[&] changePassword.isp

S| denimb01.css

) denimo03bu.gif

[&1 error.jsp

2 inquiry.jsp
~[@ logon.jsp

onter

& mylogo.aif

=+ RecordMotFound. jsp
<[] resuls.isp
Wl =

The mylogo.qgif file should appear in the list as shown below. If it doesn’t

appear, the list might need to be refreshed.
4. Right-click the Web Project WSSLABXxx folder icon.
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5. Select Refresh.

You should now see the file now in the Web Content folder, if not, go to
Windows Explorer and search for the mylogo.gif on your hard drive. Move it
to the Web Content folder in the product workspace. If you didn’t use the
default location as shown above, do a search for the workspace and the
WSSLABxx directory in it. Move the mylogo.gif file into the Web Content sub
directory under the WSSLABXxx directory. Now you can take the logo and put it
on your Web page that is still open in Page Designer. If Page Designer has been
closed just open the inquiry.jsp file.

Note: Make sure your are on the Design page, not the Preview page.
In the Project Explorer view select the mylogo.qgif file.

Hold the left mouse button down.

Drag the file to the upper left side in the Page Designer window.
Release the mouse button.

The logo is placed on the Design page.

© © N o

72 project Explorer 22\\..___(55[Iew]| =al 8
_, = = = Ll |
[‘-; H 5w |indt fycslahxoWebCankentfinguiry jspfd =
#-4@) Struts A -

[+

-8 Java Resources
=1 = WebContent
i = META-INF
- E (= theme
| B (= WEB-INF
| changePassword.jsp
- 8| denim001.css
[&] denimoo3bu.gif
[&] error.jsp ] . "

(& inquiry.jsp !Z.!.i'
logon.jsp
] - - -
[#] mylogo.mif 4| | bl

~[5] RecordiotFound.jsp Design | Saurce | Preview |
results.jsp -l =
. e et ~| -l Properties 52 Quick Edit | 2 —m

5 Thumbnails 52 . Client ... | ™ S0l =

You have started WebArt Designer, created a logo, resized a logo, saved the object
as a WebArt object, saved the logo for a Web page, placed the object on the Design
page and now you are ready to begin [“Exercise 9.5: Adding a heading 1 tag to the|

Exercise 9.5: Adding a heading 1 tag to the page

Before you begin, you must complete [“Exercise 9.4: Designing and adding a logo”]

Now you want to insert a heading below the logo.

To add a heading 1 tag:
1. Position the cursor just below the logo at the first BR tag.
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Flle Edt Toolbar @ b

Help # Link...
e

JE & | Q-

47 Anchor...

|B 7 U &  ImageFie

Background Image File

Background Music 4

Format Table Frame Page Tools Mavigate Search Pro

Chrl+Q
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| &7 & R
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l?.'.? Praoject Explorer
[+ Stru

CREY

FE Free Layout Table
FE Text Cell
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i .-

2. Click Insert from the workbench menu.

3. Click Paragraph > Heading 1 from the pop-up menu.
A frame appears that allows you to enter text.

4. Enter your company name.

& tinquiryjsp. X

inquiry. jsp - Customer Inquiry *

I6M
WESLA Y,

IBM Laboratory

o
d
o
+
o

Design [Source | Freview |

Now you want to use one of the sample pictures that comes with the product
and place this picture on the page.

You have added a company name to the input page and now you are ready to

begin [“Exercise 9.6: Adding a picture to the page” on page 131
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Exercise 9.6: Adding a picture to the page

Before you begin, you must complete [“Exercise 9.5: Adding a heading 1 tag to the]
[page” on page 129

To add a picture to the page:
1. In the Project Explorer, click the Gallery tab.

ol
File Edit Toolbar Insert ISP Format Table Frame Page Tools Mavigate Search Project Run  ‘Window
Help
] % I '-i J : J o Ell @ web
Iazyxa‘ }.-j:zzéi-_.[ | &% ¢ EBremate Syste...
I r‘ﬁf E‘; Ie ‘;"" J v ber -
mam@ésﬂmiﬂ>\ == - Flm)
i v | we v | s | B
| Banner T ==
[ ] Bullet zl EM
(. Buttan 3

<[] Phota =
) Theme
(= Title
1 Wallpaper
& @ Webart
@ Multimedia
- 87 Style Sheet
~ & Page Template

- ]_T“EE
» Sessian

esign | Source | Freview | bean
Dlropertes 52~ Queke]™ = 0] Dparord
= « | EpRelational
Record List
BODY Flle: [u0i3cy|| @ JavaBean
P Alternative text:
| @] MG Name:
* Image Layout
- Image Map
Text
| | 2

2. Expand the Image folder.
3. Select the Illustration folder.

4. On the Design page beside the Gallery view select one of the sample
illustrations, for example, use file u013cut.gif.

5. Drag the picture onto the Design page beside the logo.
The Design page now contains a picture.
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IBM Laboratory *

Seinguirylabel_Enter_custorner_number | I

%inguiry button. submit I Yinguiry. button. reset I

« Firstmessage =
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- Third m a :I
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You are almost done. Next you add moving text to the page.

You have added an image to the input page and now you are ready to begin
[“Exercise 9.7: Adding moving text to the page.”|

Exercise 9.7: Adding moving text to the page

Before you begin, you must complete [“Exercise 9.6: Adding a picture to the page’]
on page 131.

To add moving text:
1. Back to the Design page, position the cursor underneath your company name.
2. Click Insert from the workbench menu.
3. Click Paragraph > Heading 3 on the pop-up menu.
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+ First message
+ Second message
+ Third message

4. Leave the cursor positioned inside the heading 3 frame.
5. Click Insert from the workbench menu.
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6. Click Others > Marquee on the pop-up menu

The Insert Marquee window opens.

@ Insert Marquee

Text:

@ ;ter customer number and press Submit biutton to start the a;:m'

~Eehavior ~Repetition

Style Container (DIV)
SPAN with Style...

x|

Movement: -‘@ ¥ Repetthn:
Direction;  |(Auta) - Count: ‘:i

—Display speed ~Size

Delay time: I Width: ]

|pixe|s :]

scroll amaunt: | Height: |

[~ Use true speed

Iplxels LI

—Color

Background color: [ § K=
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10.

11.
12.

13.

Enter into the Text field Please enter customer number and press Submit
button to start application.

Select Slide from the Movement list.
Select Finite from the Repetition list.
Select 1 from the Count list.

The two last selections just avoid the text sliding in forever and not standing
still. If you want more movement on the page, you can change these settings.

Select Lime in the Background color list.

Click OK.

The Design page should look like:

To save some space, you can remove some of the line break tags.
Position the cursor on the BR tag.

@ rauy s x G Z]
inquiry.jsp - Customer Inquiry * El v | marqUE]N~| | standard
o -

Change focused mi

WaslABx,

IBM Laboratory

L L L Lt 4

=

Desian | Sum:aIPrwim]

14. Press the Delete key until the entry field and push buttons appear on your

page:
Next you view the page as it would appear in a browser.

15. Click the Preview tab at the bottom of the Design page.

You will notice that your heading 3 text is sliding in.
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You have added a marquee to the input page and now you are ready to begin

[“Exercise 9.8: Changing the text color.”]

Exercise 9.8: Changing the text color

Before you begin, you must complete [“Exercise 9.7: Adding moving text to the|

[page” on page 132

Sometimes you want to change the text color. There is an easy way to apply
another color to certain areas of text. To do that you return to the Design page.

To change the text color:
1. Click the Design tab.
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10.
11.

* m Laboratory

Design ’Sm.m | Freview

[ #esffoo » # | Text'CnhG
Set as Table Background Color
g 1 0 Layout Box

EEEEEET
EEEEENT

Quick Edit ﬂas@mars | Console

Select the company text (IBM) you want to change color on, by swiping the
text area with the mouse cursor.

Below the Page Designer window there are several tabs.
Click the Colors tab.

If you don’t see the Colors tab, click Windows > Show View > Colors from
the Workbench menu.

Select a color from the Color palette.
Click the down arrow next to theText color from the Color menu.
Click Set as Text Color on the drop-down menu.

You are done; now the selected text will be displayed with the color you
selected for it.

Click the Preview tab to view your completed page.
Save the file inquiry.jsp.

ST -

inquiry.jsp - Customer Inguiry * L @

9%inquiry label_Enter_custorer_number

Design lﬁucw'

Exit Page Designer.
In the Project Explorer expand the WSSLABXxx folder.
Expand the Web content folder.
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12. Right-click inquiry.jsp.
13. Click Run > Run on server on the pop-up menu.
Your new designed input page opens and you can run your Web application.

l:1ttp:,l',p'bcalhost:EIJSUIWSELABxx;’hquiry,jsp ﬂ c | a2 @ e §| i

2.
Wastatos
IBM Laboratory

You have applied color to certain areas of text on the input page.

Module recap

You have completed [Chapter 9, “Module 9. Enhancing the input page using Web)|
ftools,” on page 115]You have learned how to:

» Locate the Web application input page and start Page Designer
* View the title of the input page

* Add a style to the input page

* Preview the new style for the input page
» Start WebArt Designer

* Create a logo

* Resize the logo

» Save the object as a WebArt object

» Save the object for a Web page

* Place the object on the Design page

* Add a company name to the input page
* Add an image to the input page

* Add a marquee to the input page

* Apply color to certain areas of text

Finish your tutorial by reviewing the materials in [Chapter 10, “Summary,” on page|
139.
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Chapter 10. Summary

In this tutorial you learned how to create a simple e-business customer inquiry
application that used a Web-based front end to communicate with the business
logic written in ILE RPG residing on an iSeries server. While creating a browser
user interface, you used the iSeries Web Interaction wizard to generate input and
output JSP files as well as Page Designer to enhance the input and output Web
pages. You also added iSeries Web components to your pages, for example, Web
equivalents of iSeries command keys, input fields that accept only particular types
of data, or output fields such as subfile names. You then ran the application in the
WebSphere Test Environment that is part of the product.

Completed learning objectives

If you have completed all of the modules, you should now be able to:

* Use the Remote System Explorer perspective to edit and compile an iSeries
program or service program

» Use the Web perspective tools and views to create a Web project for your Web
application

* Create a Web interaction to use an input page and an output page and to create
a servlet to invoke an RPG program or service program to get data from the
iSeries

* Run the Web application in the WebSphere Test Environment

» Use service entry breakpoints to debug your Web application

» Create an informative error page for customers when an incorrect customer
number is entered

* Add color, pictures, change text to make the input page more attractive
More information

For more information on the product and the iSeries Web Tools, see
http://ibm.com/software/adwtools/iseries.
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Appendix. Notices

Note to U.S. Government Users Restricted Rights — Use, duplication or disclosure
restricted by GSA ADP Schedule Contract with IBM Corp.

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the I1BM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

Lab Director

IBM Canada Ltd. Laboratory
8200 Warden Avenue
Markham, Ontario

Canada

L6G 1C7

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Information concerning non-1BM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. 1992, 2005. All rights reserved.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Programming interface information
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Programming interface information is intended to help you create application
software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.
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However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks

IBM

iSeries
RPG/400
Rational
WebSphere

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

ActiveX, Microsoft, SourceSafe, Visual C++, Visual SourceSafe, Windows, Windows
NT®, Win32, Win32s and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

UNIX® is a registered trademark of The Open Group.

Other company, product, and service names may be trademarks or service marks
of others.
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